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1.  INTRODUCTION
Thank you for choosing us.
Before starting use of RGP (Remote Graphic Panel) unit and RGP-Designer, check the following information.

1.1  COMPATIBLE VERSIONS OF HARDWARE AND SOFTWARE
This Users Manual is compatible with the following versions of RGP unit and RGP-Designer.

1.1.1  RGP30 Hardware Version

•	 This Users Manual is compatible with the model RGP30 version 1.0 or later.

•	 Check the version of your RGP30 unit with referring to "2.6 TIME ZONE SETTINGS" on page 24.

1.1.2  RGP30-W Hardware Version

•	 This Users Manual is compatible with the model RGP30-W version 1.0 or later. 

•	 Check the version of your RGP30-W unit with referring to Users Manual of RGP30-W (EM-8581-D). 

1.1.3  RGP6 Hardware Version

•	 This Users Manual is compatible with the model RGP6 version 1.0 or later.

•	 Check the version of your RGP6 unit with referring to Users Manual of RGP6 (NM-8582-B; currently available 
only in Japanese), which is downloadable at our web site.

1.1.4  RGP-Designer Software Version

•	 This Users Manual is compatible with the model RGP-Designer version 1.5 or later.

•	 Check the version of your RGP-Designer with referring to "2.8 INSTALLING AND STARTING UP RGP-DE-
SIGNER" on page 25.

1.1.5  About This Users Manual

•	 This Users Manual assumes that the user is familiar with basic operation and configuration of Windows and 
the Modbus protocol.

•	 Note that the images used in this Users Manual are prototypes and they may be slightly different from actual 
images of your version of this software program.
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1.2  TRADEMARKS
Company names and product names referred to in this manual are trademarks or registered trademarks of re-
spective companies. 

QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other countries.

Microsoft, Windows, Windows Vista, Windows Server, Internet Explorer, Windows Media, Excel, Visio, DirectX, 
Visual Basic, Visual C++, and Visual Studio are trademarks or registered trademarks of Microsoft® Corporation 
in the United States and other countries

Intel, Pentium, and Xeon are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the 
United States and other countries.

	■ The following product is referred to in short in this manual.

REFERRED TO AS IN THIS MANUAL OFFICIAL TRADE NAME

Windows 10 Microsoft(R) Windows(R) 10 Operating System

1.3  TERMINOLOGY
In this Users Manual, collective terms are used to refer to RGP-Designer and respective models and versions 
of RGP.

TERM DESCRIPTION

RGP / RGP unit Collective term for Remote Graphic Panel models RGP30-N, RGP30-W and RGP6-N

RGP30-N Collective term for RGP30-N Ver1.0

RGP30-N2 Collective term for RGP30-N Ver1.1

RGP30-W Collective term for RGP30-W Ver1.0

RGP6-N Collective term for RGP6-N Ver1.0

RGP6-N2 Collective term for RGP6-N Ver1.1

RGP30 Collective term for RGP30-N and RGP30-W

RGP6 Collective term for RGP6-N 

RGP-Designer / 
this software program

Collective term for Graphic Panel Designing Software for RGP30 Series model RGP-Designer
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1.4  POINTS OF CAUTIONS

	■ GENERAL PRECAUTIONS

•	 Before removing the unit or mount it, turn off the power supply for safety.

	■ ENVIRONMENT

•	 Indoor use.

•	 When heavy dust or metal particles are present in the air, install the unit inside proper housing with sufficient 
ventilation.

•	 Do not install the unit where it is subjected to continuous vibration.  Do not subject the unit to physical impact.

•	 RGP30 must be used in an environment where the temperature is within -10 to 50°C (14 to 122°F) with relative 
humidity within 30 to 90% RH in order to ensure adequate life span and operation.

•	 RGP6 must be used in an environment where the temperature is within 0 to 40°C (32 to 104°F) with relative 
humidity within 10 to 90% RH in order to ensure adequate life span and operation.

•	 Use in clean atmosphere.  Do not expose the unit for a prolonged period of time to an atmosphere containing 
vapor of organic solvent or acidic gases, such as paint thinner, acetone, formalin or sulfurous acid gas.

•	 Do not expose the unit to direct sunlight.

	■ WIRING

•	 Do not install cables close to noise sources (relay drive cable, high frequency Line, etc.).

•	 Do not bind these cables together with those in which noises are present.  Do not install them in the same duct.

	■ CALENDAR CLOCK IN RGP30

•	 A primary lithium battery is incorporated for calendar clock IC backup. 
Backup period without external power supply is approx. 10 years at 25°C.

•	 The battery does not wear while the external power is supplied.
As the total elapsed time without power supply exceeds 10 years, the calendar clock data can no longer be 
backed up, and the calendar clock cannot keep correct date and time. 

•	 The battery is not replaceable by customer.  When replacement is required, consult us.

	■ BROWSER INSTALLED IN RGP30

Internet Explorer 11 is preinstalled in RGP30 unit and ready to be used.
However, we strongly recommend NOT to use Internet Explorer 11 as it is no longer updated and may involve 
functional and security problems.

Install a browser such as Microsoft Edge, Google Chrome, or Firefox.

	■ APPLICATION PROGRAMS ON RGP30

RGP30 employs "Windows 10 IoT Enterprise 2016 LTSB" as an operating system.

•	 Windows Update is factory-set to OFF.

•	 Basically, do not install any application programs on Windows 10 except Web browser.
We do not guarantee correct operation if an application program other than RGP-Designer and Web browser is 
installed.  Nevertheless, if an application program such as an anti-virus security software needs to be installed, 
confirm the system requirements of the software and do so at your own risk.
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	■  APPLICATION

•	 RGP is for use in general industrial environments, therefore may not be suitable for applications which require 
higher level of safety such as safety instrumentation, accident prevention systems, life-support, environmental 
protection, etc. or of reliability such as vehicle control or combustion control systems.
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1.5  PRECAUTIONS ON RGP SPECIFICATIONS
	■ CONNECTING RGP UNIT WITH PC ON WHICH RGP-DESIGNER IS RUNNING

•	 Data must be transferred to RGP unit from a single PC only.
We do not guarantee correct operation if multiple PCs transfer data to the RGP unit simultaneously.

	■ DISPLAY SCREEN (GRAPHIC PANELS) AND WEB BROWSER

•	 RGP serves as a web server and fulfills function of a display unit using Web browser on the customer's termi-
nal such as a tablet, smartphone, etc.  Note that display of Graphic Panels may be affected by the operation 
specifications of the browser used on the terminal.  Also note that theses specifications may change with the 
version update of the browser.

•	 Each display screen (hereinafter, referred to as 'Graphic Panel') created on RGP-Designer may be displayed 
differently on your browser.  Specific screen display specifications differ depending on the browser.  Check 
how the created Graphic Panel is displayed on your browser and consider differences in display, if any, when 
designing Graphic Panels.

•	 Functions of Sub Screen, Dialog Screen, and Popup Screen are implemented by using HTML iframe tags.
Behavior of created screens may be slightly different depending on the browser.  Preview created Graphic 
Panels and confirm how each screen behaves on your browser.

•	 Note that some external sites cannot be embedded in iframes due to e.g. the 'X-Frame Options' setting.  When 
embedding an external site, perform an operation test to check if the site can be accessed.

•	 When a video site such as YouTube is embedded in an iframe of Sub Screen, etc., the autoplay function 
may not work in some cases.  Perform an operation test to check if the autoplay function is forbidden by your 
browser. 

•	 Favicons may not be showing properly on Microsoft Edge depending on environment.

•	 RGP6 does not support Internet Explorer 11.  If the user tries to connect with RGP6 via Internet Explorer 11, 
the user will be redirected to the following page.

	■ ACCESSING RGP FROM MULTIPLE TERMINALS

•	 When multiple terminals write in RGP unit simultaneously, only the last data written in the RGP unit is valid.

•	 When the Bit Action type is 'Alternate' or when the Word Action type is 'Increment' or 'Decrement', data is 
subject to Read After Write verification (an operation is performed on a value read from a device and the value 
is written in the device).  Simultaneity is not guaranteed when multiple devices try to access the RGP unit 
simultaneously.  

•	 When the access type is smaller in number of bits than the device size, data is subject to Read After Write veri-
fication.  Thus, simultaneity is not guaranteed when multiple devices try to access RGP unit simultaneously.  
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1.6  RGP30 COMPONENT IDENTIFICATION

	■

SD Card Slot RGP30
POWER

RUN

HDMI

USB

ACT

+24V

0V

NC

NC

FE

LNK

Status Indicator LED

 
Power Supply Connector

USB Connector

HDMI Connector

RJ-45 Modular Jack
for Ethernet

Shutdown Button

Status Indicator LED

Power Supply Connector

USB Connector

HDMI Connector

RJ-45 Modular Jack 
for Ethernet

RGP30
POWER

RUN

ERROR

HDMI

SHUTDOWN

USB

ACT

+24V

0V

NC

NC

FE

LNK

RGP30-N, RG30P-N2 RGP30-W

 STATUS INDICATOR LED

ID COLOR STATUS

POWER Green
ON Power is ON

OFF Power is OFF

RUN Green
ON Shutdown is in process before turning Power OFF (approx. 30 sec.)

OFF Power is OFF

ERROR Red
BLINKING Communication error with slave / Setting file error  *1

OFF Operating normally

*1  ERROR LED blinks 3 or 4 times when the Power is turned ON.

	■  ETHERNET INDICATOR LED

ID COLOR STATUS

ACT Amber Turns ON during communication

LNK Green Turns ON when Link is established

	■  BUTTON

ID FUNCTION

SHUTDOWN Pressing the button for ≥ 3 seconds shuts down the unit and turns OFF Power. 

	■  TERMINAL ASSIGNMENT

NO. ID FUNCTION

1 24V Power supply (24V DC)

2 0V Power supply (0V DC)

3 NC Unused

4 NC Unused

5 FE Functional earth
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1.7  RGP6 COMPONENT IDENTIFICATION

Memory Card Slot

Reset Switch

Status Indicator LED

Jack for AC AdapterRJ-45 Modular Jack 
for Ethernet

	■  STATUS INDICATOR LED

COLOR STATUS

Green
ON Power is ON / Operating normally

BLINKING Updating firmware / Initializing system

Amber
ON Starting up 

BLINKING –

Red
ON Communication error with slave / Setting file error / EEPROM error

BLINKING –

– OFF Power is OFF / Device error

	■  SWITCH

NAME FUNCTION

RESET

Pressing the button for ≥ 3 seconds turns the status indicator LED ON Green and starts 
initialization to:
•	 Reset system settings to factory default;
•	 Delete the project having been transferred; and 
•	 Delete CA certificate.
After initialization, RGP unit is automatically restarted. 
Be sure to perform system settings.  (See Users Manual of RGP6 (NM-8582-B; currently 
available only in Japanese.))
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1.8  ABOUT RGP-DESIGNER

1.8.1  Features of RGP-Designer
Graphic Panel Designing Software for RGP30 Series (model: RGP-Designer) has the following major features.

•	 Configuring slave devices (IP address, protocol, driver, etc.) to communicate with RGP unit

•	 Designing Graphic Panels
(Max. 8 Graphic Panels and 1024 screens can be created; 10 Screens can be edited at the same time)

•	 Transferring/Receiving Graphic Panels to/from RGP unit

•	 Comparing the currently edited Graphic Panel with the one stored in the RGP unit

•	 Only RGP30-W is equipped with the monitor screen for power measuring devices compatible with RGP unit. 
For details, refer to Users Manual of RGP30-W (EM-8581-D). 

1.8.2  Communication with RGP unit
RGP unit is connected via Ethernet (TCP/IP).
Configure communication parameters including IP Address of RGP unit, port No., user ID and password on 
RGP-Designer.

1.8.3  System requirements
Prepare a PC which satisfies the following system requirements.

HARDWARE REQUIREMENTS

PC PC/AT or compatible

OS
Windows 10 Home, Professional, Enterprise editions (32-bit / 64-bit) Version 1903 or later
Windows 11 Home, Professional, Enterprise editions

DOT.NET Framework Version 4.8 or later

Memory 2 GB or greater

CPU 1 GHz or higher

Hard disk
500 MB or more
Separately secure hard disk space for user data (Project files, etc.)

Display resolution XGA (1024 x 768) or more

Language English / Japanese 
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1.9  OTHERS

1.9.1  Web server
The RGP unit serves as a web server and fulfills function of a display unit using browser on the user's terminal.

	■  RGP30

For details of the operation-verified operating systems and browsers, refer to the RGP30 specifications (ES-
8581).

	■  RGP6

For details of the operation-verified operating systems and browsers, refer to the RGP6 specifications (NS-8582; 
currently available in Japanese only). 
Note that RGP6 does not support Private/Secret mode.

NOTE

•	 The operation and/or behavior of RGP-Designer may change without notice due to specifica-
tion change of OS or browser.

1.9.2  Operating system for RGP30
RGP30 employs 'Windows 10 IoT Enterprise 2016 LTSB' as an OS.

Please be reminded that Microsoft will end security support for 'Windows 10 IoT Enterprise 2016 LTSB' in Oc-
tober 2025.
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2.  INSTALLATION AND SETUP

2.1  THINGS TO PREPARE
	■  RGP unit

	■  Things required for Network setting for RGP30 (No need for RGP6)

•	 PC

•	 USB mouse

•	 USB keyboard

•	 HDMI cable

•	 HDMI-compatible display (LCD monitor, etc.)

	■  Things required for creating Graphic Panels and system operation

•	 PC

•	 Graphic Panel Designing Software for RGP30 series (model: RGP-Designer) *1

•	 LAN cable

In addition to the above, a Wi-Fi router or a fixed IP Address contract may be necessary depending on your 
system configuration.

*1  �The software program is available for downloading at our web site. 
Please note that the program is currently downloadable from our Japanese site only.
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2.2  RGP SETUP FLOWCHART
Before starting use of the RGP unit, follow the procedure given below to configure the setting.

Initial setting for RGP30 (No need for RGP6)
➔ "2.3 TURNING ON POWER SUPPLY TO RGP30" on page 19

▼

Install RGP-Designer
➔ "2.8.1 Installation" on page 25

▼

Create a new Project
➔ 3.1 FILE MENU > "3.1.1  New(N)" on page 30

▼

Configure slave devices to connect 
➔ 3.8 PROJECT EXPLORER WINDOW > "3.8.2 Slave" on page 54

➔ "6.1 REGISTER SLAVE DEVICES" on page 88

▼

Create Screens
➔ "5. TUTORIAL (Creating Base Screens)" on page 75

▼

Save the project
➔ 3.1 FILE MENU > "3.1.4  Save As(A)" on page 31

▼

Preview the Project
➔ 3.4 TOOL MENU > "3.4.6 Preview(P)" on page 40

▼

Transfer the Project to RGP
➔ 3.4 TOOL MENU > "3.4.5 Transfer Project(T)" on page 39 
➔ "5.3 TRANSFER CREATED GRAPHIC PANEL TO RGP UNIT" on 
page 78

▼

Connect RGP with registered slave device

▼

Display the RGP web server
➔ "5.4 ACCESS RGP VIA WEB BROWSER" on page 80
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2.3  TURNING ON POWER SUPPLY TO RGP30

2.3.1  Turning ON power supply and logging in for initial setting
Login is required after turning on RGP30 unit for performing initial setting or setting change of the RGP30 unit.

1)	 Connect a USB mouse and a USB keyboard to a RGP30 unit.

2)	 Connect the RGP30 unit and a display with an HDMI cable before turning ON the power supply to the unit.

3)	 Wait for about 10 seconds until the Windows login screen appears, and enter user name and password.

	■  Default setting

	 User name: admin
	 Password  : admin

4)	 In order to change Port No. for HTTP or HTTPS connection, edit the file "RGP.ini" located in the "RGP" folder 
under C drive of the RGP30 unit. 
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5)	 Configure parameters included in the file "RGP.ini" as shown in the table below.
Edit the file using a text editor such as Windows Notepad.
Turn OFF and ON the power supply to the RGP unit to enable the changes made to the parameters values.
If invalid values are set, default values are automatically applied. 

ITEM SETTING CONTENT

HTTP Port No. 0 to 655535 (default: 80)

HTTPS Port No. 0 to 655535 (default: 443)

RGP-Designer Port No. 0 to 655535 (default: 30559)

LOG folder access level 0 to 7 (default: 0)

TLS certification file access level 0 to 7 (default: 0)

Normal power screen access level
0 to 7 (default: 0) 
*Only for RGP30-W.

Power setting screen access level
0 to 7 (default: 0) 
*Only for RGP30-W. 

[RGP]
PORT_HTTP=80
PORT_HTTPS=443

: Port No. for HTTP connection with RGP
: Port No. for HTTPS connection with RGP

[COM]
PORT_DESIGNER=30559 : Port No. for connecting with RGP-Designer

[LOG]
ACCESS_LEVEL=0 : Access level to LOG folder (0 to 7)

[SERVICE]
START_UP=0 : Parameter for updating RGP unit

[SSL]
ACCESS_LEVEL=0 : TLS certification file access level (0 to 7)

[PW]
USER_LEVEL=0
ADMIN_LEVEL=0

: Normal power screen access level (0 to 7)
: Power setting screen access level (0 to 7)
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2.4   TURNING OFF POWER SUPPLY TO RGP30

2.4.1  Turning OFF power supply
RGP30 unit must be shut down before turning OFF the power supply to the unit.

1)	 Press SHUTDOWN button for more than 3 seconds and wait for about 30 seconds until the shutdown is 
complete and RUN LED turns OFF.

2)	 Turn off the power supply to the unit after confirming that RUN LED has turned OFF. 

NOTE

•	 When instantaneous interruption or failure of power supply occurs, the RGP unit fails to shut 
down, resulting in damaging internal data.
Take a measure by protecting the unit with e.g. UPS, as needed.
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2.5  SETTING/CHANGING RGP IP ADDRESS 
Follow the procedure below for setting or changing the IP Address of the RGP unit.

2.5.1  RGP30 IP Address

1)	 On RGP, click [Start] > [Windows System Tool] > [Control Panel]. 

2)	 Open [Network and Internet] > [Network and Sharing Center], and click [Ethernet].

3)	 Open [Properties], then open the [Internet Protocol Version 4 (TCP/IPv4) Properties] window.

4)	 Configure each parameter as necessary.

Consult your network administrator for setting contents when connecting via a router.
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2.5.2  RGP6 IP Address
IP Address of RGP6 can be set on System Menu of the RGP6 web server via browser on your terminal.
Connect the terminal with RGP6 unit using an Ethernet cable and connect to the web server of the RGP6 unit.

For details, refer to Users Manual of RGP6 (NM-8582-B; currently available in Japanese only).
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2.6  TIME ZONE SETTINGS
Follow the procedure below for setting or changing the time zone of the RGP unit.

1)	 On RGP, click [Start] > [Windows System Tool] > [Control Panel]. 

2)	 Open [Clock. Language and Region] > [Dae and Time], and click [Change the timezone].

3)	 Open the Time Zone Settings dialog and change the settings as needed.

The setting is applied after rebooting the RGP30.

2.7  CONFIRMING RGP30 FIRMWARE VERSION
The firmware version of RGP30 unit can be confirmed by viewing the LOG file on Web browser.

1)	 Enter a URL in the address bar of Web browser using the correct case. 
http://(IP Address of RGP30)/LOG/LOG.txt

2)	 The RGP30 firmware version is included in a startup message and indicated as 'RGP30 Start Ver x.x.x.x' 
as shown below.
In this example, confirm that the firmware version of RGP30 is 'Ver 1.0.6.0'. 

NOTE

•	 Check the version of your RGP6 unit with referring to Users Manual of RGP6 (NM-8582-B; 
currently available only in Japanese), which is downloadable at our web site.

•	 Check the version of your RGP30-W unit with referring to Users Manual of RGP30-W (NM-
8581-D; currently available only in Japanese), which is downloadable at our web site. 



25
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

2.8  INSTALLING AND STARTING UP RGP-DESIGNER

2.8.1  Installation
The software program of RGP-Designer can be downloaded from the our web site:

1)	 Download the compressed file on your PC and decompress the file that contains 'Setup.exe'.

2)	 Execute 'Setup.exe' and follow the instructions on the installer.

NOTE

•	 If an older version of the program is already installed on your PC, uninstall the older version 
before installing the latest version.

2.8.2  Uninstallation
When the RGP-Designer needs to be upgraded or reinstalled for some reason, be sure to uninstall the existing 
program before reinstalling it.

1)	 Go to Control Panel on your PC.

2)	 Open [Programs and features] and select "RGP-Designer" from the program list and click [Uninstall].

2.8.3  Starting up RGP-Designer

1)	 Click [Start] > [M-SYSTEM] > [RGP-Designer] to start up RGP-Designer.

2)	 The initial screen of RGP-Designer appears.
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2.8.4  RGP-Designer display screen components
The screen as shown below appears when: �creating a new project; or	 ➔ "3.1 FILE MENU" on page 30
opening an existing project.➔ "3.2 EDIT MENU" on page 32

(1) Menu Bar

(2) Tool Bar

(3) Editor

(4) Project Explorer

(5) Parts Box

(8) Output

(9) Address List

(7) Property

(6) Parts List

(1)	 Menu Bar 
Menu bar contains menus for operating RGP-Designer.  Select each menu to show sub-menus.

(2)	 Tool Bar
Tool bar is a set of command icons for designing, editing, etc. for creating and editing Project.
The icons are divided into groups of 'Standard', 'Tool', 'Parts State', and 'Windows'.
Click each icon to execute its command.

(3)	 [Editor] window
Up to 10 Screens can be opened and edited at the same time.  Click each tab to switch between Screens.

(4)	 [Project Explorer] window
Components of the Project are displayed in a hierarchical structure.
Operations such as: registration and deletion of slave devices; and creation, copy, and deletion of Applica-
tion (Graphic Panels) can be performed.

(5)	 [Parts box] window
A desired part can be selected among the displayed items and pasted on the workspace.

(6)	 [Parts List] window
A list of parts allocated on the Screen which is currently displayed on the [Editor] window is displayed along 
with their respective names and types.

(7)	 [Property] window
Property attributes of the selected part or Screen are displayed.

(8)	 [Output] window
Result or progress of an operation such as a build process, error check, etc. for Project is displayed.

(9)	 [Address List] window
A list of devices used for the Screen currently being displayed on the [Editor] window.

For details of each component, refer to "3. FUNCTIONS OF MENUS AND COMMANDS" on page 30.
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2.8.5  Connecting with RGP unit
Follow the procedure below for connecting a PC with RGP unit via a network.

(1)	 Set the IP Address of the PC to e.g. '192.168.0.5' which allows connection with the IP Address '192.168.0.1 
(default)' of the RGP unit.

(2)	 Connect the PC with the RGP unit using an Ethernet cable.
Prepare a router, hub, etc. according to need.

(3)	 Turn ON the power supply to the RGP unit and confirm that the unit has started up normally and RUN LED 
turns ON Green.

(4)	 To confirm connection with the RGP unit, start RGP-Designer, click [Tool] on the Menu Bar, and select 
[Compare Project] to display the [Compare Project] dialog for setting the transfer destination RGP unit.

(5)	 On the [Compare Project] dialog, enter IP Address of the transfer destination RGP unit, Port No., and User 
name and password.  Then, click [Compare].
Default user name: admin
Default password  : admin
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(6)	 Confirm if the connection is successful or has failed.
When the connection with the RGP unit is successful, the dialog below appears.

If the connection has not been established, the dialog below appears when a predetermined time period 
has elapsed.
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2.8.6  Confirming the version of RGP-Designer

(1)	 Click [Help] on the Menu Bar, and click [Version Information] to display the [Version Information] dialog.

 

(2)	 Confirm the version of RGP-Designer. 
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3.  FUNCTIONS OF MENUS AND COMMANDS
In this section, details of menus, commands, and windows used in RGP-Designer will be described.

3.1  FILE MENU
Click [File] on the Menu Bar to display sub-menus as shown below.

Each sub-menu also appears on the Tool Bar.  
Click the icon representing each menu to execute its function.

3.1.1   New(N) 
When creating a new project, click [File] > [New] to display the [New Project] dialog as shown below.
Enter [Project Name] and [Comment], select [Model] and [Content Language] from the respective drop-down 
lists, and click [OK]. 

 
 If the [Project Name] field is left blank, the file is saved as 'New Project'.
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3.1.2   Open(O) 
When opening an existing project, click [File] > [Open], and select a Project file (extension.gpp) to open.

3.1.3   Save(S) 
When overwriting the Project file which is currently open, click [File] > [Save].

3.1.4   Save As(A) 
When saving the Project file which is currently open as another name, click [File] > [Save As] to display the [Save 
As] dialog. 
Edit the file name and click [Save].

3.1.5   Exit(X) 
When terminating RGP-Designer, click [File] > [Exit].
If any changes have been made but not saved, choose whether to save the Project file or ignore any changes.
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3.2  EDIT MENU
Click [Edit] on the Menu Bar to display sub-menus as shown below.
Edit Menu is active only when Screen are being edited.

Each sub-menu also appears on the Tool Bar.  
Click the icon representing each menu to execute its function.

3.2.1  Undo(U) 
When cancelling the last operation, click [Edit] > [Undo].
Target workspace and contents with respect to which the operation is cancelled are as shown in the table below.

WORKSPACE CONTENTS

[Project Explorer] window Property attributes of Screen under GP folder.

[Screen Editor] window Parts allocated on Screen.

3.2.2  Redo(B) 
When repeating the last operation, click [Edit] > [Redo].
Target workspace and contents with respect to which the operation is repeated are as shown in the table below.

WORKSPACE CONTENTS

[Project Explorer] window Property attributes of Screen under GP folder.

[Screen Editor] window Parts allocated on Screen.

3.2.3  Cut(T) 
When removing a part, text, etc., first select the target to be cut, then click [Edit] > [Cut].
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3.2.4  Copy(C) 
When copying a part, text, etc., first select the target to be copied, then click [Edit] > [Copy].

3.2.5  Paste(P) 
When pasting the cut or copied part, text, etc. in a new location, click [Edit] > [Paste].

3.2.6  Delete(D) 
When deleting a part, text, etc., first select the target to be deleted, then click [Edit] > [Delete].

3.2.7  SelectAll(L) 
When selecting all of parts, texts, etc. on the Screen, click [Edit] > [SelectAll].

3.2.8  Group(G) > Group(E) or Ungroup(U) 
	■  Group(E) 

When making a group of multiple objects, first select two or more objects, then click [Edit] > [Group] > [Group].

	■ Ungroup(U) 

When separating the group of multiple objects, first select the group, then click [Edit] > [Group] > [Ungroup].

3.2.9  Order(O) > BringToFront or SendToBack 
	■ BringToFront  , SendToBack 

When changing the order of display of objects overlapping each other, first select the target object, then click 
[Edit] > [Order] > [BringToFront] or [SendToBack].
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3.2.10  Align(A) 
When aligning one or multiple objects being selected, click [Edit] > [Align], then select one of the following com-
mands.

  Align Left: for aligning the selected object(s) to left.

  Align Center: for aligning the selected object(s) to center.

  Align Right: for aligning the selected object(s) to right.

  Align Top: for aligning the selected object(s) to top.

  Align Middle: for aligning the selected object(s) to middle.

  Align Bottom: for aligning the selected object(s) to bottom.

  Align Grid: for aligning the one of the four corners of selected object to the closest grid.

3.2.11  Spacing(S) 
When adjusting the space between three or more objects being selected, click [Edit] > [Align], then select one 
of the following commands.

  Equal vertical: for adjusting the vertical space to be the same.

  Equal horizontal: for adjusting the horizontal space to be the same.

3.2.12  Reset Zoom (only on the Tool bar) 

  Rest Zoom: for resetting the display magnification to 100%.

3.2.13  Zoom In / Zoom Out (only on the Tool bar) 

 Zoom In: for zooming in.

 Zoom Out: for zooming out.

 Magnification: for specifying the display magnification. 
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3.3  VIEW MENU
Click [View] on the Menu Bar to display sub-menus as shown below.

3.3.1   Perspective(P)
 Select [Perspective] for specifying whether to show or hide respective Windows used on RGP-Designer.

3.3.2   Tool Box(S)
 Select [Tool Box] for specifying whether to show or hide respective tool bars used on RGP-Designer.

3.4  TOOL MENU
Click [Tool] on the Menu Bar to display sub-menus as shown below.

Each menu also appears on the Tool Bar.  

Click the icon representing each menu to execute its function.
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3.4.1  Error Check(C) 
Select [Error Check] to perform error check on the Project being edited.
Confirm the error check result to be displayed on the [Output] window and modify the Project based on the error 
content, if any.

For specific examples of errors, refer to "3.13 OUTPUT WINDOW" on page 63.

3.4.2  Project Information(I) 

Select [Project Information] for displaying the information on the Project currently being edited and the Project 
already transferred to RGP unit.

First, select [Project Information] to display the [Get Project Information] dialog.
Enter IP Address of the RGP unit, Port No., and user name and password, then click [Get].
	 Default user name: admin
	 Default password  : admin

When the project information has been successfully obtained, the [Project Information] window showing 'Project 
Information' and 'Executable File Information' will be displayed.

[Local] represents the Project currently being edited on RGP-Designer and [Server] represents the Project al-
ready transferred to the RGP unit.
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Items are shown in red if the Local data and the Server data do not match. 

(1)

(2)

(3)
(4)

(5)

(6)

(1)	 Project Name:  Project Name entered on the [Property] window of the Project.

(2)	 Product Version: Version of RGP-Designer on which the Project was created.

(3)	 Comment: Comment entered on the [Property] window of the Project.

(4)	 Creation Date: The date and time on which the Project was newly created.

(5)	 Last Update Date: The date and time on which the Project was last updated and saved.

(6)	 Executable File Information: Information on files constituting the program of RGP-Designer 



38
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

3.4.3  Compare Project(D) 
Select [Compare Project] to display the [Compare Project] dialog for comparing the Project currently being edited 
on RGP-Designer and the Project already transferred to the RGP unit.

Enter IP Address of RGP unit, Port No., and user name and password, then click [Compare].

	 Default user name: admin
	 Default password  : admin

Confirm if the two data match or do not match each other.
When the two data match, the dialog below appears.

When the two data do not match, the dialog below appears.
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3.4.4  Build Project(B) 
Select [Build Project] to execute a build process for the Project currently being edited.
The progress and result of the build process will be displayed on the [Output] window.

Confirm if there is any error and modify the Project, if necessary.

 
For specific examples of errors, refer to "3.13 OUTPUT WINDOW" on page 63.

NOTE

The Project cannot be transferred if the Project could not be built.

If the Project cannot be transferred, check the message on the [Output] window.

If there is an error message about a build process on the [Output] window, correct the Project 
in order to fix the error.

For the description on the [Output] window, refer to "3.13 OUTPUT WINDOW" on page 63.

3.4.5  Transfer Project(T) 
Select [Transfer Project] to display the [Transfer Project] dialog for transferring the created Project to RGP unit.

Error check and a build process will be executed automatically before the project is transferred.
Enter IP Address of RGP unit, Port No., and user name and password, then click [OK].

	 Default user name: admin
	 Default password  : admin
 
Click [Abort] to terminate the transfer being processed.
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NOTE

The Project transferred to RGP unit cannot be exported to RGP-Designer.

If the Project to be transferred is used later, save the Project and use it. 

3.4.6  Preview(P) 
Select [Preview] to preview screen configuration of the Graphic Panel(s) of the currently-being-edited Project on 
Web browser.

NOTE

•	 RGP-Designer's preview function cannot show Sub Screens and Dialog Screens on a Base 
Screen in the same manner as those transferred to RGP unit and viewed via Web browser.
Instead, each Sub Screen or Dialog Screen appears as a colored square where it is sup-
posed to be displayed on the Base Screen.
However, each Sub Screen, Dialog Screen, or Popup Screen can be previewed individually 
in the manner as it is shown on Web browser.

Details of Base, Sub, Dialog, and Popup Screens, refer to "4. SCREENS (Base, Sub, Dialog, Popup)" on page 66.

3.4.7   Symbol Settings(S) and Expression Settings(E)
	■ Symbol Settings(S) , Expression Settings(E)

Select [Symbol Settings] to set symbol variables on the [Symbol Settings] window. 
Symbol variables are aliases each representing a Device address, specialized memory of RGP unit, or expres-
sion and used instead of actual Device addresses.
By using symbol variables, setting change of connected devices, etc., can be migrated simply by editing the 
symbol variables on the [Symbol Settings] window without resetting each part on the Screen.
Unlike an actual Device address such as "B/S1:X10F," a symbol variable can be a comprehensible name such 
as "Conveyor operation button."

	■ Types of symbol variables

There are three types of symbol variables as shown in the table below.

TYPE DESCRIPTION

Device symbol
Alias of Device address.
An optional symbol name can be created for each Device address.

System symbol
(RGP30-N2, RGP6-N2 only)

Alias of specialized memory of RGP unit.
Symbol name is fixed and not editable.

Note: �Not available for RGP30-N and RGP6-N as they do not have special-
ized memory.

Expression symbol
Alias of expression which is composed of Device address and symbol address.
User can define the expression and symbol name.
See "11. EXPRESSIONS" on page 179 for how to set expressions.

	■ Symbol variable specifications

•	 Up to 1024 Device symbols can be registered.

•	 System symbol is previously incorporated and cannot be edited, deleted, or newly created.

•	  Up to 80 Expression symbols can be registered.

•	 Each symbol must be named uniquely using up to 20 characters.
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	■ Points to note

RGP-Designer manages symbols using Jet 4.0 database engine.
The database conforms to SQL-89 with our extensions and subject to the following collation rules.

•	 	Not case sensitive

•	 No distinction between single-bye and double-byte for alphanumeric characters and sings

•	 No distinction among Hiragana, double-byte Katakana, and single-byte Katakana

For prohibited characters and character codes, refer to "16.1 PROHIBITED CHARACTERS" on page 210.

	■ Symbol settings and Expression settings

Symbols and expressions can be configured on the [Symbol Settings] window.
Select [Symbol Settings(S)] or [Expression Settings(E)] from Tool Menu or click each icon on Tool bar.

 Symbol Settings  - Device  -

Symbol settings  - System - 
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Symbol settings  - Expression - 

To delete a symbol variable, click to select the head of the row, and press [Delete] on your keyboard with the row 
being selected.
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3.4.8   User Accounts(U) 
Select [User Accounts] to set accounts for connecting with RGP unit via Web browser on a terminal.
Up to 8 accounts can be registered.
Set Login name and password using up to 32 characters.
Usable characters are: 0-9; A-Z; a-z; and "_ (underline)".
Access level can also be set from 0 to 7 (highest).

For detail of access level setting, refer to 3.8 PROJECT EXPLORER WINDOW > "3.8.3 Application" on page 
55.

To delete a user account, click to select the head of the row and click [Delete] on your keyboard with the row 
being selected.
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3.4.9  String Table Settings 
String Table is a list of text strings which is commonly used within one Project and used for [Text List] parts which 
display different text strings according to a value of the Monitor Address. 
That is, a [Text List] part displays a text string assigned to the [Number] on the String Table which coincides with 
the value of the Monitor Address.	 ➔"7.6 [TEXT LIST] PART" on page 129
Select [String Table Settings] to display the [String Table Settings] window.
In the String Table, register text strings and assign them to respective numbers (0 to 255).
Up to 256 text strings each with up to 255 characters can be registered.

In the example below, when the value ([Number]) of the Monitor Address is '0', "Start" is displayed as the [Text 
List] part.

For the prohibited characters for the String Table, refer to "16.1 PROHIBITED CHARACTERS" on page 210.
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3.4.10  Picture Table Settings
Picture Table is used for storing images which are commonly used within one Project. 

The images are assigned with numbers, respectively, and these numbers can be used instead of actual images 
when setting an image for a part such as Lamp or Picture which allows image setting.

NOTE

•	 Picture Table is available for RGP30-N2 (v1.1. or later), RGP-6-N2 (v1.1 or later), and  
RGP30-W only.

•	 If your RGP unit is RGP30-N or RGP-6, update the firmware to enable Picture Table.

	■ Picture Table Specifications

•	 Up to 256 pictures can be registered.

•	 Each picture must be assigned with a unique number within the range of 0 to 255.

•	 Allowable image capacity is max. 64 MByte per Screen.

•	 No limitation for the size of one image, however, if either side of the image exceeds 3840 px, the image is 
resized so as to reduce the side to 3840 px while keeping the aspect ratio.

•	 Allowable file format: BMP, JPG, JPEG, PNG, GIF, SVG

	■ Registering and editing image

1)	 Select [Picture Settings] from Tool Menu to display the [Picture Table Settings] window. 
2)	� Double-click a line of the image to edit or a blank line to register a new image on the table pane to display 

the [Select Image] dialog.
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3)	 Click [Open] or the Preview pane surrounded by the red frame to display the [Open] dialog.
4)	 Select an image, enter an optional number and comment (up to 255 characters), and click [OK] to end editing 

and register the image.

	■ Deleting image

1)	 Click the head of the line of the image to delete on the [Picture Table Settings] window. 
2)	 Press [Delete] on your keyboard to delete the line.

	■ Exporting Picture Table

Picture Table can be exported to an external folder.
Then, Picture Table can be imported again after editing the images using a retouch software or replacing im-
ages in the folder with other images.

To export Picture Table,
1)	 Click [Export] on the [Picture Settings] window to display the [Browse for Folder] dialog.
2)	 Specify the folder and click [OK].
3)	 Confirm that the Picture Table containing the files as shown in the following figure has been output. 

NOTE

•	 When Picture Table is exported, all of files and folders in the destination folder will be deleted.
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•	 Content of Picture Table folder

FILE NAME DESCRIPTION

Image file name in Picture Table Exported image file

index.csv
CSV file describing the Picture Table structure which is used when exporting 
Picture Table.

index.html
HTML file to preview images which have been exported on Browser.
Not needed when Picture Table is imported.

	■ Importing Picture Table

Images saved in an external folder can be imported and registered in Picture Table.

NOTE

•	 When Picture Table is imported, existing files in the Picture Table folder are deleted from 
RGP unit.

To import Picture Table,
1)	 Click [Import] on the [Picture Settings] window to display the [Browse for Folder] dialog.
2)	 Specify the folder and click [OK]. 
	 Note that the index.csv must be included in this folder.
3)	 Confirm that the image files have been imported and Picture Table has been updated.
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•	 Structure of index.csv (comma-delimited UTF-8)

0 imgf232e733-7712-4cfe-bb04-7dd283c8074f.png ON

1 img44cfe96a-b117-4919-85fa-14d28b94dc74.png ON

10 img2c6d16e6-1ecb-4633-a332-50f153c83c50.png Gauge 0

11 img1510ed9e-f209-4942-bb1a-5de8a75e928f.png Gauge 1

12 img30a2b8ed-87cd-4d98-b048-0868506e8ea4.png Gauge 2

 

Column No. DESCRIPTION

1
Number
Set within the range of 0 to 255.

2 Image file name

3
Comment
Set using up to 255 characters.

3.4.11  Preference(O) 
Select [Preference] to display the [Preference] setting dialog.
The settings on this dialog are generally applied to RGP-Designer.
They appear as default on the [New Project] dialog so that user can skip these settings when creating a new 
Project.

WORKSPACE CONTENTS

Default Model Selected model will be the default model on the [New Project] dialog.

Application Language

Select the language to be displayed on RGP-Designer between English (en) and 
Japanese (ja). 
When left blank, RGP-Designer will be displayed in Japanese or in English if your OS 
language is other �than Japanese.
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3.4.12  Setup Target Unit 
Select [Setup Target Unit] to display the [Setup Target Unit] dialog for setting an account for connecting RGP unit 
with RGP-Designer.

Enter an optional new user name and password, and click [OK].
Usable characters: '0-9'; 'A-Z'; 'a-z'; and '_ (underline)'.

NOTE

	■  Initialization of RGP30 Account information

To initialize RGP30 account information, delete the file "USER.bin" located in the "RGP" folder 
under C drive of the RGP unit.  The file will be initialized and the account information returns to 
default values when the RGP unit is restarted.
            Default user name: admin
            Default password  : admin



50
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

3.5  WINDOW MENU
Click [Window] on the Menu Bar to display sub-menus as shown below.

Each menu also appears on the Tool Bar.  Click the icon representing each menu to execute its function.

3.5.1   All Hide(H) 
Select [All Hide] to hide all windows except the [Editor] window on RGP-Designer.

3.5.2   All Show(S) 
Select [All Show] to display all windows on RGP-Designer.

3.5.3   Reset Layout(R) 
Select [Reset Layout] to reset the layout of all windows on RGP-Designer to default settings.

3.5.4   Screens Being Edited 
A list of Screens being edited is displayed.
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3.6  HELP MENU
Click [Help] on the Menu Bar to display sub-menu as shown below.

3.6.1  Version Information(A)
Select [Version Information] to display the [Version Information] dialog. 
	 ➔ "2.8.6 Confirming the version of RGP-Designer" on page 29. 

3.7  PARTS STATE (TOOL BAR)
Parts State is a part of Tool Bar of RGP-Designer. 

	■  Parts State

Select a value to simulatively change input value of all of parts allocated on the Screen.
For a part assigned with a Device address which inputs a bit value, a simulative value is applied to the lower bit.

When '0' is selected:
'0' is displayed and the Lamp is OFF.

When '1' is selected:
'1' is displayed and the Lamp is ON.
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3.8  PROJECT EXPLORER WINDOW
The [Project Explorer] window is used for managing slave devices and applications (Graphic Panels).

3.8.1   Project
The file name of the Project being edited is displayed.

Click the Project name to display the [Property] window showing parameter items to configure. 

ITEM DESCRIPTION

Comment Enter any comment using up to 255 characters.

ContentLanguage
Select the language of contents of the Project to be transferred to RGP unit 
between Japanese (ja) and English (en).
Default: ja

CreationDate The date and time on which the Project was newly created.

LastUpdateDate The date and time on which the Project was last updated.

Model

Select RGP model from among RGP30-N, RGP6-N, RGP30-N2, and RGP6-N2.
Select RGP30-N2 for RGP30-W.
To set the default model, refer to 3.4 TOOL MENU > "3.4.11 Preference(O)" on 
page 48. 

ProjectName Enter an arbitrary name for the Project using up to 80 characters.
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ITEM DESCRIPTION

EnableAutoShutdown  *1
Enable Auto-shutdown of RGP unit.
Default: False (Disable)

AutoShutdownAddress  *1

Specify a Device address (See "12. DEVICE ADDRESS" on page 192) which 
acts as a trigger for Auto-shutdown. 
RGP unit shuts down when the value of the Device address stays ON for 12 
seconds or longer.  
*RGP6-N2 automatically restarts after shutdown.
This setting is ignored when [EnableAutoShutdown] is set as False. 
Default: n/a (No Device address is specified)

EnableAutoReboot  *1
Enable Auto-reboot of RGP unit.
Default: False (Disable)

AutoRebootAddress  *1

Specify a Device address (See "12. DEVICE ADDRESS" on page 192) which 
acts as a trigger for Auto-reboot. 
RGP unit restarts when the value of the Device address stays ON for 12 sec-
onds or longer.
This setting is ignored when [EnableAutoReboot] is set as False. 
Default: n/a (No Device address is specified)

SendIntervalTime  *1

Interval of command transmission between RGP and PLC for monitoring [Enab-
leAutoShutdown] and [EnableAutoReboot].
Setting range:  0 to 1000 msec.
Default: 10 msec.
Note that the shorter the interval is, the higher the load on the PLC can be. 
If set to 0 msec., RGP unit transmits a command upon reception of data from 
PLC.

*1  �Available for RGP30-N2, RGP30-W and RGP6-N2 only.
This parameter does not show for RGP30-N or RGP6-N.
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3.8.2  Slave
Configure each slave device to connect with RGP unit.
Up to 32 slave devices can be connected with the RGP unit.

Right-click each slave number to configure to display the [Property] menu.
Select [Property] to display the [Slave Settings] window.

Select the slave device to connect with the RGP unit from the [Slave Driver] list.

For details of slave device setting, refer to "6.2.1 Register / Configure Slave Devices" on page 93.
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3.8.3  Application
Under [Application], GP folders (Graphic Panels) and Screens constituting each Graphic Panel are displayed in 
a tree structure.  
A single RGP unit incorporates 8 Graphic Panels which respectively correspond to folders "GP1" to "GP8."
Thus, a maximum of 8 different transition patterns that meet a variety of application needs can be created.

Click to select any of GP1 to GP8 folders to display the [Property] window showing parameter items to configure.
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ITEM DESCRIPTION

AccessLevel

Access level can be set to each GP (Graphic Panel) folder and to each user to restrict access 
to the folder.  A user is not allowed to access the folder which is set to a higher access level 
than the access level set to the user.
Set the highest access level 7 to the administrator and an access level 1 to 6 to each user in 
order to prevent unintentional changes, etc.
Set 0 if no access restriction is required.

Access level: 0 to 7 (highest)
Default: 0

ScreenSyncMode

Select between 'Sync (synchronize)' and 'Async (Asynchronize)'.
          Default: Async
          Target: Base Screen

Sync 
When the contents of the same GP folder are displayed on multiple terminals, a 
screen transition operation performed on one terminal is reflected on the rest of 
terminals.

Async
When the contents of the same GP folder are displayed on multiple terminals, 
screen display is manipulated individually according to an operation performed 
on each terminal.

ScreenUpdateInterval

Set the interval at which the Web browser requests screen data from RGP unit.
Setting range: 0 to 1000 msec.  (default: 10 msec.)
The smaller the value is, the heavier the load on the browser can be.
If set to '0 msec.', the browser sends a request command immediately upon reception of data 
from RGP unit.

SendIntervalTime

Set the command transmission interval between the RGP unit and PLC.
Setting range: 0 to 1000 msec.  (default: 10 msec.)
The smaller the value is, the heavier the load on the PLC can be.
If set to '0 msec.', the RGP unit sends a request command immediately upon reception of 
data from PLC.

Comment
Max. 255 characters
For prohibited characters and character codes, refer to "16.1 PROHIBITED CHARACTERS" 
on page 210.

HttpProtocol 

HTTP / HTTPS
Note: �When HTTPS is used, certificates must be transferred from Local Certification Authority 

Creator (model: LCA-RGP) to the RGP unit. 
For details, refer to the LCA-RGP Users Manual (NM-8581-C; currently available in 
Japanese only). 

HTTP Use HTTP only

HTTPS Use HTTPS only

BOTH Use both HTTP and HTTPS

Triggers

By setting Trigger list, a trigger action i.e., ChangeScreen action in this version of RDG-De-
signer, can be initiated by various triggers. 
For details of triggers and trigger actions, refer to "9. TRIGGER AND TRIGGER ACTION" on 
page 173.
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ITEM DESCRIPTION

EnablePopupWindow

One Popup Screen per GP folder can be created.
Set as 'True' to enable Popup Screen.
For details of Popup Screen, refer to "4.4 POPUP SCREEN" on page 72.

True

Popup Screen is enabled. 
Configure the following parameters.

MonitorAddress Select a Bit Device.

ScreenDisplayPosition

Specify the position from the range (0,0) to (3840,3840)
X: �X coordinate when the left top end of the Popup Screen 

is (0,0).
Y: �Y coordinate when the let top end of the Popup Screen 

is (0,0).

DisplayScreen Specify Popup Screen name to display.

False Popup Screen is disabled.

Note: 'Screen Update Interval' and 'Send Interval Time' do not synchronize with each other.
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3.9  Parts Box Window
On the [Parts Box] window, a list of parts to be allocated on each Screen is displayed.
When creating a Screen, select any part from the list and allocate the part by a drag-and-drop operation.

The pointer under [Common] is used to select the part already allocated on the [Editor] window, and not for al-
locating a part on the [Editor] window.

The pointer is active unless any part on the [Parts Box] window is being selected.
For details of respective parts, refer to "7. FUNCTIONS OF EACH PART" on page 97.
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3.10  EDITOR WINDOW
Each Screen is edited on the [Editor] window.
Up to 10 Screens can be opened and edited at the same time.

An error message will appear when 10 Screens are currently open and another Screen is to be opened. 
Click [OK] to close the error message, close any one of the currently-open Screens by clicking [X] to the right of 
each Screen name, and try again.
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3.11  PARTS LIST WINDOW
The [Parts List] window shows a list of parts allocated on the Screen currently displayed on the [Editor] window.  

Select any part on the list and confirm that the corresponding part on the [Editor] window becomes selected.  

Similarly, select any part on the [Editor] window and confirm that the corresponding part on the [Parts List] win-
dow becomes selected.

3.12  PROPERTY WINDOW
The property attributes of the part being selected on the [Parts List] window or on the [Editor] window are dis-
played.
Parameter items differ depending on the type of part.
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Property attributes of the part can be edited on the [Property] window.
The [Property] window has a tree structure.

Click  to expand attribute items. 

For example, by clicking  beside the parameter [Figure], the attribute items, i.e., [BackgroundColor], [Border-

Color], [BorderWidth], [DataAlign], [Font], and [FontColor] are shown and their parameter values can be edited.
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3.13  OUTPUT WINDOW
The [Output] window shows the progress and result of a build process or error check.

When an error has occurred, details of error are displayed with a specific error content (folder/part's Name).

In this example, an error message indicating 'Invalid device address (GP1)' is displayed.

Click the GP1 folder on the [Project Explorer] window to display the [Property] window.

Confirm that the values of 'MonitorAddress' under [ChangeScreen] and 'MonitorAddress' under [Popup].

Although 'EnableChangeExternalScreen' and 'EnablePopupWindow' are enabled (True) and thus the 'Monito-
rAddress' must be set, both of the values indicate 'n/a', resulting in an error.

Error message will be cleared by properly setting each 'MonitorAddress' and performing a build process or error 
check again.   

For details of 'MonitorAddress', refer to "12. DEVICE ADDRESS" on page 192.
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3.14  ADDRESS LIST WINDOW
On the [Address List] window, devices (memory areas) being used for respective slave devices are displayed 
for each GP folder.
The device being used is indicated by highlighting in green.

NOTE

•	 The Device Address assigned to a symbol variable will be on the Address List only when the 
symbol variable is being used.

3.14.1  Refresh 
Click [Refresh] to update the information.

3.14.2  Folder 
Select a GP folder from GP1 to GP8 from the drop-down list.

3.14.3  Slave 
Select a slave device from the drop-down list.
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3.14.4  Search Address 
Specify the connected slave device to search parts assigned to the device.
Click [Search Address] and select an address type from the drop-down list to display the [Device Address] dialog.

Specify [Connect driver], [Device Name], and [Address], then click [OK] to display the search result.

In the search result, the following items are displayed.
Object	 : Screens for which the specified Address is used.
Address	 : Character string of the data type, slave number, and Device address. 
Remarks	 : Parts for which the Device address is used.
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4.  SCREENS (Base, Sub, Dialog, Popup) 
Each Graphic Panel is composed of Base Screen(s), Sub Screen(s), Dialog Screen(s), and a Popup Screen. 
A maximum of 1024 Screens can be created in each GP folder.

4.1  BASE SCREEN
Base Screen is the foundation of a Graphic Panel on which various parts such as switches, lamps, text strings, 
etc. can be allocated.

Shown below is the [Property] window of Base Screen.

ITEM DESCRIPTION

BackgroundColor
Set the background color.
Default: 0,0,0 (black)

BackgroundImage
Set the background image.
Default: None

GridColor
Set the grid color.
Default: 255,0,0 (red)

GridSpacing
Set the grid interval.
Default: 10
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ITEM DESCRIPTION

GridVisible

Set as True (Enable) or False (Disable).
Enable: Grid is shown
Disable: Grid is hidden
Default: True (Enable)

FitToGrid

Set as True (Enable) or False (Disable).
Enable: Part is aligned to the grid.
Disable: Part is allocated freely ignoring the grid. 
Default: True (Enable)

NextScreen

Specify the screen to switch to when executing "ChangeScreen", the trigger action set to 
folder (GP1 - GP8) 
This value will be ignored when the screen to switch to is specified at "DisplayScreen" of trig-
ger action "ChangeScreen".
Default: 0000: (n/a)

Refer to "9. TRIGGER AND TRIGGER ACTION" on page 173 for the details of trigger ac-
tion.

Name Enter an optional name for the Base Screen using up to 16 characters.

ScreenType Indicated as 'Base Screen'.

ScreenSize

The size of the specified [Size Name] is shown. 
Or, specify the size.
     Width: Max. size: 3840;  Min. size: 240
     Height: Max. size: 3840;  Min. size: 240

SizeName

Select the screen size from below:
    VGA (640*480)
    SVGA (800*600)
    XGA (1024*768)
    SXGA (1280*1024)
    HD (1280*720)
    FHD (1920*1080)
    Custom *1

 *1 In order to customize the size, specify the size to [Screen Size].
When the specified size does not coincides the size of any of the above size names, the 
size name is automatically changed to "Custom".

Default: FHD

ViewportAttribute

Enable (True) or Disable (False) the function of Web browser on a tablet or smartphone to 
automatically increase or decrease the width of Base Screen so as to fit the width of the 
viewport of Web browser.  

Default: True

True The width of Base Screen is adjusted to the width of Web browser.

False Base Screen is displayed in its actual size.

	■  TIPS for Parts Allocation

•	 Max. 1024 parts can be allocated on a single Screen.
Note that grouped parts are respectively counted but also counted one as a group.  
Thus, the maximum number of parts which can be allocated will be less than 1024 when there are grouped 
parts. 

•	 There also may be a case where parts cannot be added any more before the number of parts reaches the 
maximum number due to capacity shortage.
In such a case, delete some switch actions or move some parts to a Sub Screen, and try again.

	■  About Background Image (common to all Screens)

•	 When an image with a large size is selected, the image is converted to a thumbnail image of max. 640*640 to 
reduce memory consumption on RGP-Designer.
The original large size image will be transferred to RGP unit,
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4.2  SUB SCREEN
Sub Screen is used as a part (subroutine) of a Graphic Panel.

Various parts such as switches, lamps, text strings, etc. can be allocated on a Sub Screen in the same manner 
as a Base Screen, however, the following parts cannot be used for Sub Screen.
		  [Select Base Screen] switch
		  [Select Sub Screen] switch
		  [Display Dialog Screen] switch
		  [Sub Screen Display Frame]
		  [Dialog Screen Display Frame]     

Shown below is the [Property] window of Sub Screen.

ITEM DESCRIPTION

BackgroundColor
Set the background color.
Default: 0,0,0 (black)

BackgroundImage
Set the background image.
Default: None

GridColor
Set the grid color.
Default: 255,0,0 (red)

GridSpacing
Set the grid interval.
Default: 10
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ITEM DESCRIPTION

GridVisible

Set as True (Enable) or False (Disable).
Enable: Grid is shown
Disable: Grid is hidden
Default: True

FitToGrid

Set as True (Enable) or False (Disable).
Enable: Part is aligned to the grid.
Disable: Part is allocated freely ignoring the grid. 

Default: True

NextScreen

Specify the sub screen to switch to when executing "ChangeSubScreen", the trigger action 
set to base screen 
This value will be ignored when the screen to switch to is specified at "DisplayScreen" of trig-
ger action "ChangeSubScreen", or when the sub screen is not displayed on the Sub Screen 
Frame.
Default: 0000: (n/a)

Refer to "9. TRIGGER AND TRIGGER ACTION" on page 173 for the details of trigger ac-
tion.

Scale

Acquire or specify the display scale (ratio) of contents within the frame to display the sub 
screen specified "NextScreen" property.
Setting range: 0.5 to 1.0 in 0.1 unit
Default: 1.0

Name Enter an optional name for the Sub Screen using up to 16 characters.

ScreenType Indicated as 'Sub Screen'.

ScreenSize

The size of the specified [Size Name] is shown. 
Or, specify the size
     Width: Max. size: 3840;  Min. size: 240
     Height: Max. size: 3840;  Min. size: 240

SizeName

Select the screen size from below:
    VGA (640*480)
    SVGA (800*600)
    XGA (1024*768)
    SXGA (1280*1024)
    HD (1280*720)
    FHD (1920*1080)
    Custom *1

 *1 In order to customize the size, specify the size to [Screen Size].
When the specified size does not coincides the size of any of the above size names, the 
size name is automatically changed to "Custom".

Default: FHD

For details of how to use Sub Screens, refer to "7.3 [CHANGE SUB SCREEN] SWITCH" on page 110.
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4.3  DIALOG SCREEN
Dialog Screen is a Screen for prompting individual setting.

Various parts such as switches, lamps, text strings, etc. can be allocated on a Dialog Screen in the same manner 
as a Base Screen, however, the following parts cannot be used for Dialog Screen.
		  [Select Base Screen] switch
		  [Select Sub Screen] switch
		  [Display Dialog Screen] switch
		  [Sub Screen Display Frame]
		  [Dialog Screen Display Frame]     

While a Dialog Screen is displayed, operations can be performed only on the Dialog Screen. 

NOTE

•	 While a Dialog Screen is displayed, screen transition by an operation performed on another 
terminal will not be reflected even in Sync mode.

[Close] button is allocated on each Dialog Screen as standard. 

Shown below is the [Property] window of Dialog Screen.
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ITEM DESCRIPTION

BackgroundColor
Set the background color.
Default: 0,0,0 (black)

BackgroundImage
Set the background image.
Default: None

GridColor
Set the grid color.
Default: 255,0,0 (red)

GridSpacing
Set the grid interval.
Default: 10

GridVisible

Set as True (Enable) or False (Disable).
Enable: Grid is shown
Disable: Grid is hidden
Default: True

FitToGrid

Set as True (Enable) or False (Disable).
Enable: Part is aligned to the grid.
Disable: Part is allocated freely ignoring the grid. 
Default: True

Name Enter an optional name for the Dialog Screen using up to 16 characters.

ScreenType Indicated as 'Dialog Screen'.

ScreenSize

The size specified as [Size Name] is shown. 
Or, specify the size
     Width: Max. size: 3840;  Min. size: 240
     Height: Max. size: 3840;  Min. size: 240

SizeName

Select the screen size from below:
    VGA (640*480)
    SVGA (800*600)
    XGA (1024*768)
    SXGA (1280*1024)
    HD (1280*720)
    FHD (1920*1080)
    Custom *1

 *1 In order to customize the size, specify the size to [Screen Size].
When the specified size does not coincides the size of any of the above size names, the 
size name is automatically changed to "Custom".

Default: VGA

For details of how to use Dialog Screens, refer to "7.4 [SHOW DIALOG] SWITCH" on page 118.
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4.4  POPUP SCREEN
Popup Screen is displayed on all terminals which are viewing the same GP folder, and is used for a notification 
from slave devices, for example.

Various parts such as switches, lamps, text strings, etc. can be allocated on Popup Screen in the same manner 
as Base Screen, however, the following parts cannot be used for Popup Screen.
		  [Select Base Screen] switch
		  [Select Sub Screen] switch
		  [Display Dialog Screen] switch
		  [Sub Screen Display Frame]
		  [Dialog Screen Display Frame]

Shown below is the [Property] window of Popup Screen.

ITEM DESCRIPTION

BackgroundColor
Set the background color.
Default: 0,0,0 (black)

BackgroundImage
Set the background image.
Default: None

GridColor
Set the grid color.
Default: 255,0,0 (red)

GridSpacing
Set the grid interval.
Default: 10

GridVisible

Set as True (Enable) or False (Disable).
Enable: Grid is shown
Disable: Grid is hidden
Default: True

FitToGrid

Set as True (Enable) or False (Disable).
Enable: Part is aligned to the grid.
Disable: Part is allocated freely ignoring the grid. 
Default: True

Name Enter an optional name for the Popup Screen using up to 16 characters.
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ITEM DESCRIPTION

ScreenType Indicated as 'Popup Screen'.

ScreenSize

The size specified as [Size Name] is shown. 
Or, specify the size
     Width: Max. size: 3840;  Min. size: 240
     Height: Max. size: 3840;  Min. size: 240

SizeName

Select the screen size from below:
    VGA (640*480)
    SVGA (800*600)
    XGA (1024*768)
    SXGA (1280*1024)
    HD (1280*720)
    FHD (1920*1080)
    Custom *1

 *1 In order to customize the size, specify the size to [Screen Size].
When the specified size does not coincides the size of any of the above size names, the 
size name is automaticclay changed to "Custom".

Default: Custom (320, 240)

For details of how to use Popup Screen, refer to 3.8 PROJECT EXPLORER WINDOW > "3.8.3 Application" on page 
55.
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4.5  SCREEN TRANSITION MODE 
Screen transition mode can be selected between 'Sync Mode' and 'Async Mode'.

ITEM DESCRIPTION

Async Mode
The Screens in the same GP folder can be switched individually according to an operation 
performed on each terminal.

Sync Mode

•	 When 'EnableChangeExternalScreen' is disabled
Screens can be switched by 'Change Base Screen' switch only. 
A switch operation performed on one terminal is applied to all terminals which are viewing 
the same GP folder.  *1

    Default page: Page 1

*1  �The switch operation for screen transition is not applied to a terminal on which a Dialog 
Screen is currently displayed.

•	 When 'EnableChangeExternalScreen' is enabled
Screens can be switched according to a value of the device set as the Monitor address. 
The change in the device value is applied to all terminals which are viewing the same GP 
folder. *1

    Page 1 is displayed when the device value is 0 or out of range.

  Default page: Page 1

*1  �The switch operation for screen transition is not applied to a terminal on which a Dialog 
Screen is currently displayed.
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5.  TUTORIAL (Creating Base Screens)

5.1  CREATE FIRST BASE SCREEN
1)	 Go to the [Project Explorer] window, right-click on [Screen] in the "GP1" folder to display sub-menus, and 

select [Add] to display the [Add Screen] dialog.

2)	 Enter 'sample' in the [Screen Name] field, check [Base Screen], and click [OK].  

3)	 Confirm that the Base Screen named 'sample' has been created.
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5.2  ALLOCATE SWITCH AND LAMP

5.2.1  Allocate a Switch

1)	 Go to the [Parts Box] window, click [Switch], and confirm that the row of [Switch] is highlighted in blue and 
selected.
Move the cursor to a desired position on the Base Screen, and click the desired position to allocate the 
[Switch] part.

2)	 The part has been allocated in the state being selected.
Drag the corner of the frame to resize the part.

Note that the allocation position and the size of the part can be confirmed or changed on the [Property] window 
as well.  Change the values of the property attributes under [Layout].
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5.2.2  Allocate a Lamp

1)	 Go to the [Parts Box] window, click [Lamp], and confirm that the row of [Lamp] is highlighted in blue and 
selected.
Move the cursor to a desired position on the Base Screen, and click the desired position to allocate the 
[Lamp] part.

2)	 The part has been allocated in the state being selected.
Drag the corner of the frame to resize the part.

3)	 Click [File] on the Menu Bar, select [Save as] to display the [Save as] dialog, and click [Save] to save the 
Project.
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5.3  TRANSFER CREATED GRAPHIC PANEL TO RGP UNIT
The description will be made on the premise that the PC on which RGP-Designer is running and the RGP unit 
are connected via a Network.    ➔ "2.8.5 Connecting with RGP unit" on page 27

1)	 Click [Tool] on the Menu Bar and select [Transfer Project].

2)	 Error check and a build process will be executed automatically.
Confirm that the completion message appears on the [Output] window when the error check and build pro-
cess have been completed normally,  

3)	 When an error has occurred, details of error are displayed with a specific error content.
Correct error, if any, according to the message.
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4)	 As the build process has been completed normally, the [Transfer Project] dialog appears.
Enter IP Address of RGP unit, Port No., and user name and password, then click [OK].

		  Default user name: admin
		  Default password  : admin

5)	 Confirm that the completion message appears on the [Output] window when the Project has been trans-
ferred normally.
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5.4  ACCESS RGP VIA WEB BROWSER

5.4.1  Set URL

1)	 Enter 'http://(IP Address)/(Folder name)/html/(Page No.).html' in the address bar of Web browser.

	 IP Address	 : IP Address of RGP unit
		  Folder name	: 'GP1' in which Screens have been created.
		  Page No.	 : Page No. as indicated beside the Screen name. ('page1' in this example)
				      The page number is assigned to each Base Screen automatically by RGP-Designer.

2)	 Enter 'http://192.168.13.13/GP1/html/page1.html' in the address bar and confirm that the Screen as shown 
below is displayed.
If the Screen is not displayed, check the address, and try again.
When the proxy server is used, confirm that the browser settings are properly configured.
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5.4.2  Display Screen on Browser of RGP30

1)	 Connect RGP30 unit with an LCD monitor, etc. via an HDMI cable.

2)	 On the RGP30 unit, click [Start] > [Windows Accessories] > [Internet Explorer].

3)	 Enter 'http://192.168.13.13/GP1/html/page1.html' in the address bar of Internet Explorer.
Alternatively, using the loopback address, enter 'http://127.0.0.1/GP1/html/page1.html'.

4)	 Confirm that the Screen as shown on the previous page is displayed.

NOTE

When there is an HTTP or HTTPS in a URL, set the [Http Protocol] property on "3.8.3 Applica-
tion" on page 55 to enable the HTTP and HTTPS. 

5.4.3  Manipulate the Switch

1)	 Click the green Switch to perform an ON/OFF operation.

2)	 Confirm that the Lamp turns ON/OFF in conjunction with the ON/OFF operation.
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5.4.4  Set a switch action

1)	 Go back to RGP-Designer, double-click the Switch icon allocated on the Base Screen to display the [Lamp/
Switch] dialog.

2)	 Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window for registering and 
defining actions performed when the [Switch] part is clicked.
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3)	 Register 'No.1: Bit Operation' as a switch action.
In addition, select 'Alternate' as [BitActionType] so that the value of 'B\S0:GB0' set as [TargetAddress] is 
inverted every time the [Switch] part is clicked.

ON operation

OFF operation

B/S0:GB0 value
0  --->  1

1  --->  0
B/S0:GB0 value

[BitActionType] includes 'Set', 'Reset', and 'Momentary' in addition to 'Alternate.
For details, refer to "8. SWITCH ACTION" on page 160.

In the above example, the Slave No. S0 represents a virtual slave in the internal memory of RGP unit, and 
GB0 represents a Bit Device.
For details, refer to "15.3.1 Common internal device" on page 203.
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5.4.5  Configure the Lamp

1)	 On RGP-Designer, double-click the Lamp icon allocated on the Base Screen to display the [Lamp/Switch] 
dialog. 
Click the [Lamp] tab.

2)	 Select 'Bit' as [Monitor Type], select '1' as [Bit Number], and specify [Monitor Address] as 'B/S0:GB0'.
The target monitor address is monitored at every data scan interval and display of the [Lamp] part changes 
according to the data status.

3)	 Confirm that, by this setting, the displayed image is changed based on the value of Bit No.GB0 in the Bit 
area of the Slave No. S0. 

Lamp ON

Lamp OFF

B/S0:GB0
  value: 1

value: 0
B/S0:GB0 
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5.5  CREATE SECOND BASE SCREEN

5.5.1  Allocate parts

1)	 In the same manner as the first Base Screen, right-click on [Screen] in the "GP1" folder, and select [Add] to 
display the [Add] dialog.

2)	 Enter 'sample2 ' in the [Screen name] field, check [Base Screen], and click [OK]. 

In this example, one [Switch] part. two [Numerical Display] parts. and two [Label] parts are to be allocated 
on the second Base Screen.

	■ Switch

1)	 Allocate a Switch on the Base Screen.

2)	 Register 2 types of WordActions (W/S0:GW0; Increment, W/S0:GW1; Decrement) for the Switch.
For details of Switch Action settings, refer to "8.2 REGISTER SWITCH ACTIONS" on page 161.

Switch Action 1 setting

Switch Action 2 setting
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	■ [Numerical Display] Parts 

1)	 Allocate two [Numerical Display] parts on the Base Screen.

2)	 Respectively register 'W/S0:GW0' and 'W/S0:GW1' as [MonitorAddress] of which to display values.
For details of [Numerical Display] parts, refer to "7.5 [NUMERIC DISPLAY] PART" on page 124.

	■ Label

1)	 Allocate two [Label] parts on the Base Screen.

2)	 Enter the values of [MonitorAddress], respectively for the [Label] parts. 
For details of [Label] parts, refer to "7.10 SHAPE ([RECTANGLE], [CIRCLE], [LINE], [LABEL], [PICTURE]) 
PARTS" on page 145.

3)	 Once the allocation of parts has been completed, transfer the Project to the RGP unit. 
											           ➔ "3.4.5 Transfer Project(T)" on page 39

5.5.2  Preview to check operation

1)	 Enter 'http://192.168.13.13/GP1/html/page2.html' in the address bar of Web browser.

2)	 Confirm that each value is incremented or decremented each time either [Switch] part is clicked.



87
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

5.6  SWITCH BETWEEN BASE SCREENS
In this section, the method of switching between Base Screens ('sample' and 'sample2') will be described.

5.6.1  Allocate [ChangeScreen] switch

1)	 Allocate a [Change Base Screen] switch on each of 'sample' Base Screen and 'sample2' Base Screen.

2)	 Double-click the switch icon to display the [Lamp/Switch] dialog on each Base Screen.
Confirm that the 'Change Base Screen' switch action is registered to the [Change Base Screen] switch as 
standard. 

5.6.2  Edit Switch Action

1)	 Click [Edit Action] to display the [Switch Action] setting window.

2)	 Specify the Screen name in the [DisplayScreen] field to which to switch so that the Screen changes from 
'sample' to 'sample2' and from 'sample2' to 'sample'.

'sample1' setting 'sample2' setting

5.6.3  Transfer Project / Preview to check operation

1)	 Transfer the Project to the RGP unit. ➔ "3.4.5 Transfer Project(T)" on page 39

2)	 Enter 'http://192.168.13.13/GP1/html/page1.html' or 'http://192.168.13.13/GP1/html/page2.html' in the ad-
dress bar of Web browser to preview each Base Screen.

3)	 Confirm that the Screen switches to one another each time the [Change Base Screen] switch is clicked. 
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6.  TUTORIAL (Slave Communication)

6.1  REGISTER SLAVE DEVICES
Slave devices which are connected with RGP unit need to be registered on RGP-Designer.
Before registration, make sure that RGP unit, slave devices, and PC are connected with each other via a hub, 
etc. 

Parameters items differ depending on the type of slave device.
Refer to each of the following sections in this chapter which applies to the slave device type. 

The following is the general procedure for registering a slave device. 

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave number to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 In the initial state, 'n/a' is displayed indicating that no slave device is set.
To register a Modbus/TCP slave device, select 'Modbus/TCP Device', for example, and click [OK].

5)	 After the completion of slave device registration, proceed to "6.2 DATA DISPLAY" on page 93.
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6.1.1  Modbus/TCP Device
RGP unit communicates with each Modbus slave device using the Modbus master function. 
Follow the procedure below to register Modbus/TCP slaves.

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave number to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 Select 'Modbus/TCP Device' as [Slave Driver].

5)	 Configure the parameters referring to the table below for Modbus/TCP communication.

ITEM DESCRIPTION

IP Address
IP Address (TCP/IPv4) 
Enter IP Address of the slave device.

Port No.
Set the Port number for Modbus/TCP. 
Default: 502 (Standard port No. for Modbus/TCP) 
Port number other than 502 can be set, if necessary on account of the system.

Timeout (sec.)
No response time is detected. 
Timeout error occurs after a predetermined time period has elapsed. 
Setting range: 1 to 10 sec.

Unit ID
Enter Modbus node No. of the slave device. 
For the device with no node No. setting, refer to the instruction manual of the 
device and set the number as appropriate. 
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6.1.2  MELSEC Q / iQ-R / iQ-F Series (Mitsubishi Electric)
RGP unit communicates with each SLMP-compatible device using the SLMP client function.
Follow the procedure below to register SLMP-compatible devices as slaves.

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave number to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 Select 'MELSEC Q(Mitsubishi Electric)', 'MELSEC iQ-R(Mitsubishi Electric)' or 'MELSEC iQ-F(Mitsubishi 
Electric)' as [Slave Driver].

5)	 Configure the parameters referring to the table below for SLMP communication.

ITEM DESCRIPTION

IP Address
IP Address (TCP/IPv4) 
Enter IP Address of the MELSEC device.

Port No.
Set the Port number for SLMP. 
Default: 8192 (in decimal)

Timeout (sec.)
No response time is detected. 
Timeout error occurs after a predetermined time period has elapsed. 
Setting range: 1 to 10 sec.

Network No.
Set the SLMP network No.
Set to '0' (in decimal). *1

Node No.
Set the SLMP node No.
Set to '255' (in decimal). *1

PC No.
Set the SLMP processor No.
Set to '1023' (in decimal). *1

*1  �Basically, the number is to be set in decimal.   
If the number is in hexadecimal, convert it to decimal. 
For details, refer to "SLMP Reference Manual" of Mitsubishi Electric. 
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6.1.3  DL8 / DL30 / TR30
RGP unit communicates with our DL8, DL30, or TR30 unit using the Modbus master function. 

Follow the procedure below to register the devices as Modbus/TCP slaves.

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave number to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 Select 'DL8(M-System) Modbus/TCP', 'DL30(M-System) Modbus/TCP', or 'TR30(M-System) Modbus/TCP'  
as [Slave Driver].

5)	 Configure the parameters referring to the table below for Modbus/TCP communication.

ITEM DESCRIPTION

IP Address
IP Address (TCP/IPv4) 
Enter IP Address of the DL8, DL30, or TR30 unit.

Port No.
Set the Port number for Modbus/TCP. 
Default: 502 (Standard port No. for Modbus/TCP) 
Port number other than 502 can be set, if necessary on account of the system.

Timeout (sec.)
No response time is detected. 
Timeout error occurs after a predetermined time period has elapsed. 
Setting range: 1 to 10 sec.

Unit ID Set to '1' (default).

Note: Be sure to enable Modbus slave function of the DL8, DL30, or TR30 unit on PC configurator software.
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6.1.4  FA-M3 (Yokogawa Electric)
RGP unit communicates with Yokogawa Electric's FA-M3 using the Modbus master function. 

Follow the procedure below to register FA-M3 as a Modbus/TCP slave.

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave number to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 Select 'FA-M3(Yokogawa)' as [Slave Driver].

5)	 Configure the parameters referring to the table below for Modbus/TCP communication.

ITEM DESCRIPTION

IP Address
IP Address (TCP/IPv4) 
Enter IP Address of the slave device.

Port No.
Set the Port number for Modbus/TCP. 
Default: 502 (Standard port No. for Modbus/TCP) 
Port number other than 502 can be set, if necessary on account of the system.

Timeout (sec.)
No response time is detected. 
Timeout error occurs after a predetermined time period has elapsed. 
Setting range: 1 to 10 sec.

Unit ID Set the Modbus node number of FA-M3.
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6.2  DATA DISPLAY
Taking an our remote I/O (model: R7E-SV4) for Modbus/TCP with 4 analog input points as an example, follow 
the procedure below for displaying analog input data (0 to 10000) on a Screen.

	■ Parameter setting of R7E-SV4

IP Address: 192.168.13.7 (set on PC configurator software model: R7CON)
Port No.: 502 (default)
Unit ID: 1 (fixed)

6.2.1  Register / Configure Slave Devices
	■ Register slave device

1)	 Go to the [Project Explorer] window.

2)	 Right-click or double-click the slave No. 'S1' to configure to display the [Property] menu.

3)	 Click [Property] to display the [Slave Settings] window.

4)	 Select 'Modbus/TCP Device' as [Slave Driver].

5)	 Enter the parameter values for R7E-SV4, and click [OK].

	■ Associate data and monitor device

Analog data (Word data) of the R7E-SV4 unit can be accessed from the following Device addresses.

R7E-SV4 DATA DEVICE ADDRESS for S1

Analog input (CH1) W/S1:3X1

Analog input (CH2) W/S1:3X2

Analog input (CH3) W/S1:3X3

Analog input (CH4) W/S1:3X4
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6.2.2  Allocate Parts for Data Display
	■ Allocate a [Numeric Display] part

1)	 Go to the [Project Explorer] window.

2)	 Right-click on [Screen] in the "GP1" folder, and select [Add] to display the [Add] dialog.

3)	 Enter 'sample3 ' in the [Screen name] field, check [Base Screen], and click [OK]. 

4)	 Allocate 4 [Numeric Display] parts and 4 [Label] parts on the Base Screen. 
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	■ Associate parts and Device Addressesv

1)	 With the [Numeric Display] part for CH1 on the top being selected, confirm the [Property] window. 
In the initial state, 'W/S1:3X1' is set as [MonitorAddress].

By the above settings, word data of Address 1 in 3X (analog input area) of Slave No. S1 is used.

2)	 With the [Numeric Display] part for CH2 being selected, confirm the [Property] window.

3)	 The initial state for CH2 is the same as S1. 
To change the value of [MonitorAddress], click the row of [MonitorAddress] to display the [Device Address] 
dialog.

4)	 Click ▲ in the [Address] field to change the value to '0002', and click [OK].

5)	 In the same manner, change the values of [Address] to '0003' and '0004', respectively for CH3 and CH4.
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	■ Preview Data Display

1)	 Transfer the Project.

2)	 Enter 'http://192.168.13.13/GP1/html/page3.html' in the address bar of Web browser.

3)	 Confirm that input data of R7E-SV4 is displayed.
0 to 10000 values are displayed in accordance with analog input change.
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7.  FUNCTIONS OF EACH PART
In this section, the functions and role of each part to be allocated on a Screen will be described.

For details of the following functions mentioned in this chapter, also refer to the followings.

•	 Edit Action			  ➔ "8. SWITCH ACTION" on page 160

•	 Monitor Address		  ➔ "12. DEVICE ADDRESS" on page 192

•	 Interlock function		 ➔ "13. INTERLOCK FUNCTION" on page 194

•	 Figure			   ➔ "14. FIGURE" on page 196
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7.1  LAMP / SWITCH

7.1.1  Appearance on the [Parts Box] window

Lamp

Switch

Select a [Lamp] or [Switch] part on the [Parts Box] window, allocate it on Base Screen, and resize the part as 
needed by dragging the corner of the frame.

On the Base Screen, a [Lamp] part is displayed in a dotted square.

By changing parameter values on the [Lamp/Switch] dialog or the [Property] window, Lamps and Switches in 
various shapes and appearances can be created.
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7.1.2  Function
Lamp is a part whose image changes in accordance with change in value (Bit Device: ON(1)/OFF(0), word de-
vice: 0 to 15) of the monitored device.

Switch is a part which functions as an operation switch on a Screen.

7.1.3  Parameter items
In order to edit parameter values, click the Lamp or Switch allocated on Base Screen to display the [Property] 
window showing the parameter items and values.

Alternatively, double-click on the part to display the [Lamp/Switch] dialog, on which [Common], [Lamp], and/or 
[Switch] tabs are shown depending on the settings on the [Common] tab.

For details, refer to [Common] Tab, [Lamp] Tab (appears when [Enable Lamp] is checked), and [Switch] Tab (ap-
pears when [Enable Switch] is checked) in this section.
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	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the Lamp/Switch using up to 16 characters.

Enable Lamp Check to enable the Lamp function.

Enable Switch Check to enable the Switch function.

Enable Picture Text
Check to display a caption as an image of [Text] and [Font].
Note: This setting is ignored when using Internet Explorer 11.
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	■ [Lamp] Tab (appears when [Enable Lamp] is checked)

ITEM DESCRIPTION

Monitor Type

Bit
Part's image is changed in accordance with a bit data value. 
Specify [Bit Number] and [State Condition].

Word
 �Part's image is changed in accordance with values of lower 4 bits of 
word data.  (Value: 0 to 15)

Bit Number (the number of bits)

Set the number of bits to be used.
1: 1 bit
2: 2 bits
3: 3 bits
4: 4 bits

State Condition

Specify the condition for determining the appearance of the part,

Position: �The appearance is determined based on the bit position to be ON. 
Refer to the table below (BIT COMBINATION (State Condition: Posi-
tion) for correlation between Device Address and Bit Status for deter-
mining the appearance.

Combination: �The appearance is determined based on combination of values of 
Device Address. 
For details, refer to the table on the next page (BIT COMBINA-
TION (State Condition: Combination) for correlation between 
Device Address and Bit Pattern for determining the appearance.

Monitor Address

For details, refer to "12. DEVICE ADDRESS" on page 192.

On the [Property] window, the value of [MonitorAddress] is shown as below. 

Click  to display the [Device Address Collection Editor] dialog. ➔ P103

Figure For details, refer to "14. FIGURE" on page 196.
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	■ BIT COMBINATION (State Condition: Position)

MONITORED DEVICE ADDRESS
BIT NO. BIT STATUS

3 2 1 0

OFF OFF OFF OFF
1 to 4

ALL Bits: OFF

OFF OFF OFF ON Bit 0: ON

OFF OFF ON ON or OFF 2 to 4 Bit 1: ON

OFF ON ON or OFF ON or OFF 3 to 4 Bit 2: ON

ON ON or OFF ON or OFF ON or OFF 4 Bit 3: ON
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	■ BIT COMBINATION (State Condition: Combination)

MONITORED DEVICE ADDRESS
BIT NO. BIT PATTERN

3 2 1 0

OFF OFF OFF OFF

1 to 4

Bit Pattern: 0
Bit Pattern: 00
Bit Pattern: 000 
Bit Pattern: 0000

OFF OFF OFF ON

Bit Pattern: 1
Bit Pattern: 01
Bit Pattern: 001 
Bit Pattern: 0001

OFF OFF ON OFF

2 to 4

Bit Pattern: 10
Bit Pattern: 010 
Bit Pattern: 0010

OFF OFF ON ON
Bit Pattern: 11
Bit Pattern: 011 
Bit Pattern: 0111

OFF ON OFF OFF

3 to 4

Bit Pattern: 100 
Bit Pattern: 0100

OFF ON OFF ON
Bit Pattern: 101 
Bit Pattern: 0101

OFF ON ON OFF
Bit Pattern: 110 
Bit Pattern: 0110

OFF ON ON ON
Bit Pattern: 111 
Bit Pattern: 0111

ON OFF OFF OFF

4

Bit Pattern: 1000

ON OFF OFF ON Bit Pattern: 1001

ON OFF ON OFF Bit Pattern: 1010

ON OFF ON ON Bit Pattern: 1011

ON ON OFF OFF Bit Pattern: 1100

ON ON OFF ON Bit Pattern: 1101

ON ON ON OFF Bit Pattern: 1110

ON ON ON ON Bit Pattern: 1111

Note: �When [Bit Number] is set to '2 to 4', 'Bit Pattern: 0000' is displayed on the [Figure] window on the [Lamp/Switch] 
dialog. 
The rightmost one is the least significant bit. 
The below figure shows the correlation between the Monitored Device Address and Bit Pattern.

Bit Pattern
Monitor Address
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	■ [Device Address Collection Editor] dialog.

The below figure shows correlation between Members on [Device Address Collection Editor] and Monitored 
Device Address.

Bit0, Bit1, Bit2, and Bit3 correspond to Member[0], Member[1], Member[2], and Member[3], respectively.

Monitor Address
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	■ [Switch] Tab (appears when [Enable Switch] is checked)

ITEM DESCRIPTION

Action

Select the Switch Action from: �Bit Operation;  
Word Operation; 
Change Base Screen;  
Switch Sub Screen; 
Show Dialog; and  
CGI Call.

Max. 8 actions can be registered. 
For details, refer to "8. SWITCH ACTION" on page 160. 

Delay OFF (sec.)
Set the delay time until the Switch is turned OFF.
Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Delay ON (sec.)
Set the delay time until the Switch is turned ON.
Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Touch Beep

Enable or disable the switch operation sound for the terminal with the sound 
function.

False: No sound 
True: Output sound by touch/click operation *1

Enable Interlock

Enable or disable Interlock function.

When enabled, [Monitor Address] and [Interlock Condition] fields are displayed.

For details of Monitor Address, refer to "12. DEVICE ADDRESS" on page 192. 

For details of Interlock Function, refer to "13. INTERLOCK FUNCTION" on page 
194.

Figure For details, refer to "14. FIGURE" on page 196. 

*1  Operation sound will not be output when the switch action is not executed due to Interlock, etc. 
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7.2  [CHANGE BASE SCREEN] SWITCH

7.2.1  Appearance on the [Parts Box] window

 

Allocate the [Change Base Screen] switch on Base Screen, and resize the part as needed by dragging the cor-
ner of the frame.

[Change Base Screen] switch can be allocated only on Base Screens.
In the same manner as a [Lamp] or [Switch] part, the [Change Base Screen] switch can be displayed in different 
ways by changing values of its property attributes.

7.2.2  Function
The [Change Base Screen] switch is used for switching Base Screens from one to the other when it is clicked.

1)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.

2)	 Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window.

3)	 Click the down arrow to the right of the [DisplayScreen] field to display the drop-down list, and select which 
Base Screen to switch to.
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7.2.3  Parameter items

1)	 Click the [Change Base Screen] switch allocated on the Base Screen to display property attributes on the 
[Property] window.

2)	 Edit each parameter value, as necessary.
For details, refer to [Common] Tab and [Switch] Tab in this section.
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	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

3)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.
Confirm that this dialog has [Common] tab and [Switch] tab.

4)	 Edit parameter values on each tab as necessary.

	■ [Common] Tab

ITEM DESCRIPTION

Name
Enter an optional name for the [Change Base Screen] switch using up to 16 
characters.

Enable Lamp Grayed out and cannot be checked.

Enable Switch Grayed out and cannot be unchecked.

Enable Picture Text
Check to display a caption as an image of [Text] and [Font].
Note: This setting is ignored when using Internet Explorer 11.
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	■ [Switch] Tab

ITEM DESCRIPTION

Action Switch Action is fixed to 'Change Base Screen'. 

Delay OFF (sec.)
Set the delay time until the Switch is turned OFF. *1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Delay ON (sec.)
Set the delay time until the Switch is turned ON.*1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Touch Beep

Enable or disable the switch operation sound for the terminal with the sound 
function.
False: No sound 
True: Output sound by touch/click operation *2

Enable Interlock

Enable or disable Interlock function.
When enabled, [Monitor Address] and [Interlock Condition] fields are displayed.
For details of Monitor Address, refer to "12. DEVICE ADDRESS" on page 192. 
For details of Interlock Function, refer to "13. INTERLOCK FUNCTION" on page 
194.

Figure For details, refer to "14. FIGURE" on page 196. 

*1  Delay time is set to prevent erroneous operation and chattering.
*2  Operation sound will not be output when the switch action is not executed due to Interlock, etc. 
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7.3  [CHANGE SUB SCREEN] SWITCH

7.3.1  Appearance on the [Parts Box] window

  
Allocate the [Change Sub Screen] switch on Base Screen, and resize the part as needed by dragging the corner 
of the frame.

[Change Sub Screen] switch can be allocated only on Base Screens.

In the same manner as a [Lamp] or [Switch] part, the [Change Sub Screen] switch can be displayed in different 
ways by changing values of its property attributes.

7.3.2  Function
The [Change Sub Screen] switch is used for displaying a Sub Screen on a [Sub Screen Frame] or switching the 
Sub Screen being displayed to another Sub Screen when it is clicked. 

The [Change Sub Screen] switch is used also for hiding a Sub Screen being displayed.
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7.3.3  Parameter items

1)	 Click the [Change Sub Screen] switch on the Base Screen to display parameter items to configure on the 
[Property] window.

2)	 Edit each parameter value, as necessary.
For details, refer to [Common] Tab and [Switch] Tab in this section.
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	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

3)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.
Confirm that this dialog has [Common] tab and [Switch] tab.

4)	 Edit parameter values on each tab as necessary.

	■ [Common] Tab

ITEM DESCRIPTION

Name
Enter an optional name for the [Change Sub Screen] switch using up to 16 
characters.

Enable Lamp Grayed out and cannot be checked

Enable Switch Grayed out and cannot be unchecked

Enable Picture Text
Check to display a caption as an image of [Text] and [Font].
Note: This setting is ignored when using Internet Explorer 11.
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	■ [Switch] Tab

ITEM DESCRIPTION

Action
Max. 3 Sub Screen Display Frames can be allocated on a Base Screen.
3 'Change Sub Screen' Actions are registered as standard and not editable.
For details of Switch Actions, refer to "8. SWITCH ACTION" on page 160.   

Delay OFF (sec.)
Set the delay time until the Switch is turned OFF. *1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Delay ON (sec.)
Set the delay time until the Switch is turned ON. *1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Touch Beep

Enable or disable the switch operation sound for the terminal with the sound 
function.
False: No sound 
True: Output sound by touch/click operation *2

Enable Interlock

Enable or disable Interlock function.
When enabled, [Monitor Address] and [Interlock Condition] fields are displayed.
For details of Monitor Address, refer to "12. DEVICE ADDRESS" on page 192. 
For details of Interlock Function, refer to "13. INTERLOCK FUNCTION" on page 
194.

Figure For details, refer to "14. FIGURE" on page 196. 

*1  Delay time is set to prevent erroneous operation and chattering.
*2  Operation sound will not be output when the switch action is not executed due to Interlock, etc. 
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7.3.4  How to Use Sub Screens
Description will be made on the premise that Sub Screens have already been created.

1)	 First, determine the display location of a Sub Screen.

Click to select [Sub Screen Frame] on the [Part Box] window, and allocate the frame in an optional location 
on Base Screen.

2)	 Click to select [Change Sub Screen] switch on the [Part Box] window and allocate the switch in an optional 
location on the Base Screen so as not to overlap the [Sub Screen Frame].
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3)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.

4)	 Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window.

5)	 Select 'ChangeScreen' as [ScreenTransitionMethod].

6)	 As [TargetFrame(Frame)], select the Sub Screen Frame having been allocated.

7)	 Click the down arrow to the right of the [DisplayScreen] field to display the drop-down list, and select which 
Sub Screen to display.



116
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

The Sub Screen being displayed will not be automatically hidden.
To hide the Sub Screen, follow the procedure below.

1)	 Allocate another [Change Sub Screen] switch so as not to overlap the [Sub Screen Frame].

3)	 Double-click the newly allocated Switch to display the [Lamp/Switch] dialog.

4)	 Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window.

5)	 Select the Sub Screen Frame to be hidden as [TargetFrame(Frame)], leave [DisplayScreen] as '0000: n/a', 
and click [OK].
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[Sub Screen Frame] can be used to display external contents.
To do so, select 'NavigateByURL' as [ScreenTransitionMethod], and enter a URL of the contents to display in the 
[TransitionDestination] field.

Note: In order to display the information about the power measuring devices on RGP30-W sub screen, specify 
'NavigateByURL'.
For details, refer to Users Manual of RGP30-W (EM-8581-D). 
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7.4  [SHOW DIALOG] SWITCH

7.4.1  Appearance on the [Parts Box] window

 
Allocate a [Show Dialog] switch, and resize the part as needed by dragging the corner of the frame.

[Show Dialog] switch can be allocated only on Base Screens.
In the same manner as a [Lamp] or [Switch] part, the [Show Dialog] switch can be displayed in different ways by 
changing values of its property attributes.

7.4.2  Function
The [Show Dialog] switch is used for displaying a Dialog Screen on a [Dialog Frame] when it is clicked.

1)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.

2)	 Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window.

3)	 Click the down arrow to the right of the [DisplayScreen] field to display the drop-down list, and select which 
Dialog Screen to display.
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7.4.3  Parameter items

1)	 Click the [Show Dialog] switch on the Base Screen to display parameter items to configure on the [Property] 
window.

2)	 Edit each parameter value, as necessary.
For details, refer to [Common] Tab and [Switch] Tab in this section.

	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

3)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.
Confirm that this dialog has [Common] tab and [Switch] tab.

4)	 Edit parameter values on each tab as necessary.	
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	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the [Show Dialog] switch using up to 16 characters.

Enable Lamp Grayed out and cannot be checked.

Enable Switch Grayed out and cannot be unchecked.

Enable Picture Text
Check to display a caption as an image of [Text] and [Font].
Note: This setting is ignored when using Internet Explorer 11.
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	■ [Switch] Tab

ITEM DESCRIPTION

Action Switch Action is fixed to 'Show Dialog'. 

Delay OFF (sec.)
Set the delay time until the Switch is turned OFF. *1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Delay ON (sec.)
Set the delay time until the Switch is turned ON. *1

Setting range: 0.0 to 30.0 sec.
Default: 0.0 sec.

Touch Beep
Enable or disable the switch operation sound for the terminal with the sound function.
False: No sound 
True: Output sound by touch/click operation *2

Enable Interlock

Enable or disable Interlock function.
When enabled, [Monitor Address] and [Interlock Condition] fields are displayed.
For details of Monitor Address, refer to "12. DEVICE ADDRESS" on page 192. 
For details of Interlock Function, refer to "13. INTERLOCK FUNCTION" on page 194.

Figure For details, refer to "14. FIGURE" on page 196. 

*1  Delay time is set to prevent erroneous operation and chattering.
*2  Operation sound will not be output when the switch action is not executed due to Interlock, etc. 
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7.4.4  How to Use Dialog Screens
Description will be made on the premise that Dialog Screens have already been created.

1)	 First, determine the display location of a Dialog Screen.  
Click to select [Dialog Frame] on the [Part Box] window, and allocate the frame in an optional location on 
Base Screen.

2)	 Click to select [Show Dialog] switch on the [Part Box] window, and allocate the switch in an optional location 
on the Base Screen.

Unlike Sub Screens, Dialog Screens are each provided with a [Close] button, and thus a [Show Dialog] switch 
can be allocated so as to overlap a [Dialog Frame].

The below figure shows a state where the [Show Dialog] switch is allocated so as to overlap the Dialog Frame. 
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3)	 Double-click the Switch icon to display the [Lamp/Switch] dialog.
Click the [Switch] tab, and click [Edit Action] to display the [Switch Action] setting window.

4)	 Select the [Dialog Frame] having been allocated as [TargetFrame(Frame)]. 

5)	 Click the down arrow to the right of the [DisplayScreen] field to display the drop-down list, and select which 
Dialog Screen to display. 
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7.5  [NUMERIC DISPLAY] PART

7.5.1  Appearance on the [Parts Box] window

 

The below figure shows a [Numeric Display] part allocated on a Base Screen.

7.5.2  Function
[Numerical Display] parts are used not only for displaying values of monitored Device Address but also for enter-
ing a value from a Screen and output the value to the Device.

On the [Property] window, select 'True' or 'False' for [EnableInput] under [Common] to enable or disable numeric 
input.
The appearance (color, font) of the part can be changed according to the displayed value.

	■ Points to Note for Numeric Input

•	 	Input Dialog is used for numeric input.
While Input Dialog is displayed, a switch operation for Screen transition performed on another terminal will not 
be applied even in Sync Mode.

•	 Some Web browsers have an option to forbid to display Input Dialog.
If this option is checked, numeric input will be invalid.
In such a case, close the Web browser, open the Web browser, and access the same page again.

	■ Input method

The input method differs between RGP30 to RGP6  as described in the table below.

INPUT METHOD RGP30 RGP6

Start Input Touch/Click [Numeric Display] Part. Touch/Click [Numeric Display] Part.

Input Input in prompt dialog. Directly input in <Input> tag of the Part.

Determine Input Click [OK] on prompt dialog.
Enter key is pressed or the focus is lost. 
Click [OK] on confirm dialog. 

Check Input After [OK] is clicked on prompt dialog. Before confirm dialog is displayed.
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7.5.3  Parameter items
Edit parameter values on the [Property] window to change the content and mode of numeric display.
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	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

7.5.4  Scaling
On the [Property] window, select 'True' for [Scale] to scale Device data to engineering unit values.

ITEM DESCRIPTION

False (Disable) Device data is displayed as it is without being scaled.

True (Enable)

Device data is scaled.
Select [Scale type] from the followings.
  · Fixed Point
  · Offset Gain
  · Zero Span
When 'FixedPoint' is selected, set the decimal point position (1 to 3).
When 'Offset Gain' or 'Zero Span' is selected, set the number of decimal places 
(0 to 3).  See the table below.
When an engineering unit value is input, the entered value is scaled in reverse 
and rounded to be written in the Device.

The table below shows available combinations.

VARIABLE TYPE SCALING FIXED POINT POSITION NO. OF DECIMAL PLACES

I8, U8, I16, U16, I32, U32

FixedPoint 1 to 3   (default: 1) Not available

Offset Gain Not available 0 to 3   (default: 3)

Zero Span Not available 0 to 3   (default: 3)

F32
Offset Gain Not available 0 to 3   (default: 3)

Zero Span Not available 0 to 3   (default: 3)

The table below shows Input range for each variable type when [Fixed point] is selected as [Scaling type].

FIXED POINT POSITION

VARIABLE TYPE 1 2 3

I8 -12.8 to 12.7 -1.28 to 1.27 -0.128 to 0.127

U8 0.0 to 25.5 0.00 to 2.55 0.000 to 0.255

I16 -3276.8 to 3276.7 -327.68 to 327.67 -32.768 to 32.767

U16 0.0 to 6553.5 0.00 to 655.35 0.000 to 65.535

I32 -214748364.8 to 214748364.7 -21474836.48 to 21474836.47 -2147483.648 to 2147483.647

U32 0.0 to 429496729.5 0.00 to 42949672.95 0.000 to 4294967.295
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7.5.5  Offset Gain
When [Offset Gain] is selected as [Scaling type], configure the parameters according to the table below.

ITEM DESCRIPTION

Equation
Y = AX + B
X= Y / A - B

Parameter

A Gain: Property  (default: 1.0)

B Offset: Property  (default: 0.0)

X Value before scaling (input value)

Y Value after scaling (display value)

7.5.6  Zero Span
When [Zero Span] is selected as [Scaling type], configure the parameters according to the table below.

ITEM DESCRIPTION

Equation
Y = Zr + (Sr - Zr) * (X - Zb) / (Sb - Zb)
X = (Y - Zr) * (Sb - Zb) / (Sr - Zr) + Zb

Parameter

Zb Zero (input) property  (default: 0)

Sb Span (input) property  (default: 10000)

Zr Zero (display) property  (default: 0)

Sr Span (display) property  (default: 10000)

X Value before scaling (input value)

Y Value after scaling (display value)
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7.5.7  Alarms
Set each of Alarm display HH, H, L, and LL to True (Enable) to change the form of the part according to the 
displayed value.
Configure the parameters referring to the table below.

ITEM DESCRIPTION

Alarm display HH Enable Alarm display HH.  Default: False (Disable)

Alarm setpoint HH
Specify the setpoint for Alarm display HH. Default: 10000
Form of part changes according to the set Alarm figure HH as the displayed value 
becomes ≥ Alarm setpoint HH. 

Alarm figure HH Set the figure for Alarm display HH.

Alarm display H Enable Alarm display H.  Default: False (Disable)

Alarm setpoint H
Specify the setpoint for Alarm display H.  Default: 9000
Form of part changes according to the set Alarm figure H as the displayed value 
becomes ≥ Alarm setpoint H.. 

Alarm figure H Set the figure for Alarm display H.

Alarm display L Enable Alarm display L.  Default: False (Disable)

Alarm setpoint L
Specify the setpoint for Alarm display L.  Default: -9000
Form of part changes according to the set Display format L. 

Alarm figure L
Set the figure for Alarm display L. 
Form of part changes according to the set Alarm figure L as the displayed value 
becomes ≤ Alarm setpoint L. 

Alarm display LL Enable Alarm display LL.  Default: False (Disable)

Alarm setpoint LL
Specify the setpoint for Alarm display LL.  Default: -10000
Form of part changes according to the set Alarm figure LL as the displayed value 
becomes ≤ Alarm setpoint LL. 

Alarm figure LL Set the figure for Alarm display LL.

NOTE

•	 Alarm setpoints should be set so as to be HH>H>L>LL. 
No error occurs even if the above condition is not met, however, an error message will ap-
pear when a build process is executed.

•	 The priority of alarm display is HH>H, and LL>L (when Alarm setpoint H is higher than Alarm 
setpoint HH.
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7.6  [TEXT LIST] PART

7.6.1  Appearance on the [Parts Box] window

 
The below figure shows a [Text List] part allocated on a Base Screen.

7.6.2  Function
[Text List] is a part for displaying a character string which is assigned to the part from the String Table, or display-
ing a different character string from the String Table according to Device data.
When the value of Device data is not on the String Table, nothing will be displayed.

The String Table is commonly used within one Project. 
For details of the String Table, refer to  3.4 TOOL MENU > "3.4.9 String Table Settings" on page 44.

7.6.3  Parameter items
Shown below is the [Property] window of [Text List]. 
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	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

	■ Common

ITEM DESCRIPTION

Monitor Address Set the Monitor Address.

Monitor Type

Select the Monitor Type.

Bit The value of Device data is '0' or '1'. 

Word

When [StringTableEnable] is set as 'True': 0 to 255 
         Data is acquired from the String Table according to the value.

When [StringTableEnable] is set as 'False': 0 to 15 
         Data of the character string assigned to the part is acquired. 

Name Enter an optional name for the [Text List] part using up to 16 characters.

Figure

When [StringTableEnable] is 'True': Indicated as '(DisplayFormat)'.
        Data is acquired from the String Table.

When [StringTableEnable] is 'False': Indicated as 'StringDisp[] Array' 
         �The [Disp Collection Editor] dialog is used.  (See the Figure below.)

StringTableEnable

Select between 'True' and 'False' to enable or disable the String Table.

Default: True

True The String Table is used.

False The Disp Collection Editor is used. 
(See the Figure on the next page.)

The figure below shows the [Disp Collection Editor] dialog.
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ITEM DESCRIPTION

Members
When the Monitor Type is 'Bit': '0' or '1' can be registered.
When the Monitor Type is 'Word': '0 to 15' can be registered.

BackgroundColor Set the background color.

BorderColor Set the border color.

BorderWidth
Set the border width.
Setting range: 0 to 10

Font Select the font.

FontColor Set the font color.

Text Define a text string using up to 256 characters.

TextAlign
Select the text align to: 'Left', 'Center', or 'Right'.
Default: Center
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7.7  GAUGE ([TANK], [METER], [BAR GAUGE]) PARTS

7.7.1  Appearance on the [Parts Box] window

The below figure shows [Tank], [Meter], and [Bar Gauge] parts allocated on a Base Screen.

7.7.2  Function
[Gauge] is a part for visualizing and displaying analog data with a meter or a scale.
The indicator of [Gauge] can be changed to red or yellow when the value enters any of the alarm zones (HH, H, 
L, LL) which can be arbitrary set.
That is, the color of indicator can be changed according to whether the input value is Normal or has entered H/L 
or HH/LL alarm zone.

 

NOTE

•	 The indicator color is translucently displayed, and the specified color may appear differently 
when viewed on Web browser.
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7.7.3  Parameter items

1)	 Click the [Gauge] part allocated on the Base Screen to display the [Property] window showing parameter 
items to configure.

2)	 Edit parameter values as necessary.
The edited values are reflected on the corresponding items on each tab of the [Gauge] window.
For details, refer to [Common] Tab and [Data] Tab in this section.

	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

 3)	 Double-click the [Gauge] part on the Base Screen to display the [Gauge] window.
Confirm that the [Gauge] window has [Common] tab and [Data] tab.
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	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the [Gauge] part using up to 16 characters.
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	■  [Data] Tab

ITEM DESCRIPTION

Data Type Select the type of data to display.

Monitor Address
Set the Monitor Address. 
For details, refer to "12. DEVICE ADDRESS" on page 192.  

Max Set the upper limit of data.

Min Set the lower limit of data.

HH Check [HH] to enable input of HH setpoint value. 

H Check [H] to enable input of H setpoint value. 

L Check [L] to enable input of L setpoint value. 

LL Check [LL] to enable input of LL setpoint value. 

Note:  �

•	 When viewed on Web browser, data exceeding HH or LL is indicated in red and data exceeding H or L is indicated in 
yellow. 
On RGP-Designer, only the image of the Gauge part is displayed without data indication.

•	 Setting range differs depending on the data type. 
For details, refer to "15.2.1 Data Type" on page 202.



136
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

7.8  SIMPLE GAUGE

7.8.1  Appearance on the [Parts Box] window

The below figure shows a [Simple Gauge] part allocated on a Base Screen.

7.8.2  Function
[Simple gauge] is a part for visualizing and displaying analog data with a meter or a scale in the same manner as 
[Tank], [Meter], and [Bar Gauge] parts.  ➔ "7.7 GAUGE ([TANK], [METER], [BAR GAUGE]) PARTS" on page 
132
Unlike those parts, [Simple gauge] does not have a background image and can be represented by any form by 
combining with a [Picture] part, for example.
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7.8.3  Parameter items

1)	 Click the [Simple gauge] part allocated on the Base Screen to display the [Property] window showing pa-
rameter items to configure.

2)	 Edit parameter values as necessary.
The edited values are reflected on the corresponding items on each tab of the [Simple gauge] window.
For details, refer to [Common] Tab and [Display] Tab in this section.

	■ Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.
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	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the [Simple gauge] part using up to 16 characters.

Datatype Select the Data type to display.

MonitorAddress
Specify Device address as a source of Simple gauge.
For details, refer to "12. DEVICE ADDRESS" on page 192. 

GaugeType

Select Gauge type from the following.
•	  Vertical     :  Vertical gauge
•	  Horizontal:  Horizontal gauge
•	  Meter       :  Meter gauge

	■ Display

ITEM DESCRIPTION

Limit
Set the upper limit, lower limit, and alarm setpoints for data assigned to [Simple 
gauge] part.  These parameters can be configured only on [Display] tab of the 
[SimpleGauge] window.

Max Set the upper limit of data.

Min Set the lower limit of data.

EnableHH Enable Alarm display HH.

Alarm setpoint HH Specify the setpoint for Alarm display HH.

EnableH Enable Alarm display H. 

Alarm setpoint H Specify the setpoint for Alarm display H.

EnableL Enable Alarm display L.

Alarm setpoint L Specify the setpoint for Alarm display L.

EnableLL Enable Alarm display LL.

Alarm setpoint LL Specify the setpoint for Alarm display LL.

Note: 

•	 Be sure to enable [ShowScale], or alarms will not be displayed even when they are enabled.

•	 When data falls within each set point, the color of Gauge indicator changes according to [HL_LimitColor] and 
[HHLL_LimitColor] settings under [Gauge Indicator] on the Property window.

•	 Setting range of each setpoint differs according to Data type.  
For details, refer to "15.2.1 Data Type" on page 202.

Example of alarm display

Alarm display HH

Alarm display H

Alarm display L

Alarm display LL
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	■ Gauge scale

ITEM DESCRIPTION

ScalePitch

Select the scale intervals from the followings.

None : No scale is shown.

I10 : Scale between Max and Min is divided into 10% intervals.

I25 : Scale between Max and Min is divided into 25% intervals.

I50 : Scale between Max and Min is divided into 50% intervals.

ShowScale Specify whether to show the scale and alarms.

ScaleColor Set the color of scale.

LH_Color Set the color for H and L.

LLHH_Color Set the color for HH and LL.

	■ Gauge Indicator

ITEM DESCRIPTION

IndicatorColor Set the color of Gauge Indicator.

StartAngle
Set the starting angle (angle at Min) of indicator of Meter in the range of 0 to 360°. 
* �The angle starts at the 12 o'clock position and increases in clockwise direction. 
* This parameter is available only when the gauge type is Meter.

Delta
Set the angle between the starting angle and final angle (angle at Max) of indicator 
of Meter in the range of 90 to 360°.
* This parameter is available only when the gauge type is Meter.

IndicatorType Select the form of indicator referring to the table below.

•	 Forms of Indicator

Gauge 
Type

Indicator Type

A B C

Vertical

Horizontal

Meter
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7.8.4  Setting Window

1)	 Double-click the [Simple gauge] part allocated on the Base Screen to display the [Simple Gauge] window 
with [Common] Tab and [Display] Tab.

2)	 Edit parameter values as necessary.
The parameters on this window are the same as those on the [Property] window.
For details, refer to "7.8.3 Parameter items" on page 137.

	■ [Common] Tab

CATEGORY ITEM PARAMETER NAME REMARK

COMMON
Name Name

Configurable on [Property] window 
and [Simple Gauge] window

Gauge Type Gauge Type

DISPLAY

Data Type Data Type

Monitor Address Button Monitor Address

Upper limit Max

Configurable only on [Simple 
Gauge] window 

Lower limit Min

HH check box EnableHH

HH setpoint HH setpoint

H check box EnableH

H setpoint H setpoint

L check box EnableL

L setpoint L setpoint

LL check box EnableLL

LL setpoint LL setpoint
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	■ [Display] Tab

CATEGORY ITEM PARAMETER NAME REMARK

Gauge Scale

Scale Pitch Interval

LL&HH Color Button LLHH_Color

L&H Color Button LH_Color

Scale Line Color Button Scale line color

Show Scale check box ShowScale

Gauge Indicator

Gauge form Type

Starting angle Start ∠ 

Delta Delta

Indicator Color Button Indicator color

Preview Simple gauge preview Preview
Confirm the appearance of 
Simple gauge.
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7.9  QR CODE

7.9.1  Appearance on the [Parts Box] window

The below figure shows a [QR Code] part allocated on a Base Screen.

7.9.2  Function
[QR Code] is a part which encodes a character string from the String Table (commonly used within one Project) 
or a character string assigned to each part, which corresponds to the value of the set Monitor Address, and rep-
resents the encoded character string as a QR code.

For details of how to use String Table, refer to "3.4.9 String Table Settings" on page 44.

Sample of QR code
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7.9.3  Parameter items
Click the [QR Code] part allocated on the Base Screen to display the [Property] window showing parameter 
items to configure.

	■ Layout

ITEM DESCRIPTION

Size

Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0 
* �When the specified size is a rectangle, QR Code will be displayed as a square 

at the center of the part.

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.
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7.9.4  NOTE

•	 RGP-Designer supports QR Code Model 2. 
We assume that created codes can be read by general two-dimensional barcode readers in e.g. smart-
phones but we do not guarantee that they can be read by any barcode reader.

•	 Be reminded the the character string is held in utf-8 for [QR Code] part.

	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the [QR Code] part using up to 16 characters.

Input Mode

Select data type of the QR code source.

Text : �Enter the source of character string for the QR code in the [Text] 
field.

Number : �Specify the source of character string for the QR code from the 
String Table. 
Enter a value that corresponds to the Number of String Table in the 
[Number] field.

Address : �Specify the source of character string for the QR code from the 
String Table. 
Enter a Device address which represents the Number of String 
Table in the [MonitorAddress] field.

Text Specify a character string using up to 255 characters for the QR code source.

Number Specify Number of String Table.

MonitorAddress Specify Monitor address.

BackgroundColor * Set the color of the background cell of QR code.

ForegroundColor * Set the color of the foreground cell of QR code.

* �When [Input Mode] is set to Address, settings of [BackgroundColor] and [ForegroundColor] are ignored and they are dis-
played in black and white, respectively.

* In [Input Mode], the models where Address can be selected are RGP30-N2, RGP30-W and RGP6-N2.
* �QR code may not be recognized correctly when the density of [BackgroundColor] and that of [ForegroundColor] are close 

to each other. 
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7.10  SHAPE ([RECTANGLE], [CIRCLE], [LINE], [LABEL], [PICTURE]) PARTS

7.10.1  Appearance on the [Parts Box] window

The below figure shows [Rectangle], [Circle], [Line], and [Label] parts allocated on a Base Screen.

The below figure shows a picture frame and a picture when allocated in the picture frame on the Base Screen.

7.10.2  Function
Shape ([Rectangle], [Circle], [Line], [Label], [Picture]) parts are to be allocated on Base Screen, Sub Screen, 
Dialog Screen, or Popup Screen.

Various Figures and symbols can be created using the Shape parts in combination, enabling functional screen 
display.
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7.10.3  Parameter items
Click the Shape part allocated on the Screen to display the [Property] window showing parameter items to 
configure. 
The below figure shows the parameter items of a [Line] part.

 
Items under [Common] and [Layout] are common to all Shape parts, and items under [Misc] vary depending on 
the type of Shape part.

	■  Layout

ITEM DESCRIPTION

Size
Specify the size of the part. 
     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Location
Specify the position from the range (0,0) to (3840,-3840)
X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the Shape part using up to 16 characters.
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	■ Misc: Rectangle

ITEM DESCRIPTION REMARK

FillColor
Set the color to fill the part.
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

LineColor
Set the color of the outline of the part.
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

LineWidth
Set the width of the outline.
Setting range: 0 to 10 pixels

–

	■ Misc: Circle

ITEM DESCRIPTION REMARK

CenterCoordinates Set the center coordinates of the part. –

FillColor
Set the color to fill the part.
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

HorizontalRadius Set the horizontal radius of the part. –

LineColor
Set the color of the outline of the part.
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

LineWidth
Set the width of the outline.
Setting range: 0 to 10 pixels

–

VerticalRadius Set the vertical radius of the part. –
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	■ Misc: Line

ITEM DESCRIPTION REMARK

LineColor
Set the color of the outline of the part.
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

LineWidth
Set the width of the outline.
Setting range: 0 to 10 pixels

–

	■ Misc: Label

ITEM DESCRIPTION REMARK

BackgroundColor
Set the background color. 
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

BorderColor
Set the border color. 
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

BorderWidth
Set the border width.
Setting range: 0 to 10 pixels

–

Font
Select the font.
[Select Font] dialog appears.

The dialog may look different 
depending on OS.

FontColor
Set the font color. 
[Select Color] dialog appears.

Set the border color. 
[Select Color] dialog appears.

PictureText

Select 'True' to display a caption as an image of 
[Text] and [Font].
True: display as an image
False: display as a text

This setting is ignored when us-
ing Internet Explorer 11.

Text Define a text string using up to 80 characters. –

TextAlign Select the text align to: 'Left', 'Center', or 'Right'. –
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	■ Misc: Picture

ITEM DESCRIPTION REMARK

BackgroundColor
Set the background color. 
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

BackgroundImage
Set an image. 
[Select Image] dialog appears.

The dialog may look different 
depending on OS.

BorderColor
Set the border color. 
[Select Color] dialog appears.

The dialog may look different 
depending on OS.

BorderWidth
Set the border width.
Setting range: 0 to 10 pixels

–

EnablePictureTable

Specify the source of [BackgroundImage].
False: �Image set as [BackgroundImage] is used.
True: �Image of Number in Picture Table that cor-

responds to the value of [MonitorAddress] 
is used.

MonitorAddress Specify the Monitor Address.
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7.11  CONTAINER ([SUB SCREEN FRAME], [DIALOG FRAME]) PARTS

7.11.1  Appearance on the [Parts Box] window

The below figure shows a [Container] part allocated on a Base Screen.

7.11.2  Function
[Sub Screen Frame] and [Dialog Frame] are parts used for specifying the location and size of another Screen 
when displaying the Screen on the Base Screen.
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7.11.3  Parameter items

1)	 Click the [Sub Screen Frame] part or [Dialog Frame] part allocated on the Base Screen to display the [Prop-
erty] window showing parameter items to configure.

2)	 Edit the parameter values as necessary, to change the size of the Frame part or define the location to dis-
play on the Base Screen.

 

	■ Layout

ITEM DESCRIPTION

Location
Specify the position from the range (0,0) to (3840,-3840).

X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Scale
Specify the display scale (ratio) of contents within the frame.

Setting range: 0.5 to 1.0 in 0.1 increments

Size
Specify the size of the part.

     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.
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	■ [Common] Tab

ITEM DESCRIPTION

FrameType The type of frame is indicated.

Name Enter an optional name for the Container part using up to 255 characters.

	■ Behavior

Parameter items differ depending on whether [InitialFrameTransition] is set as 'Screen No' or 'URL'.

1)	 When [InitialFrameTransition] is set as 'Screen No'

ITEM DESCRIPTION

DisplayScreen Specify which Sub Screen or Dialog Screen to display.

FrameDisplayMethod Fixed to 'Switch'.

2)	  When [InitialFrameTransition] is set as 'URL'

ITEM DESCRIPTION

URL Enter the URL of the contents to display.

FrameDisplayMethod Fixed to 'Switch'.

NOTE

•	 When [InitialFrameTransition] is set to 'Screen No' and a Sub Screen is specified as [Dis-
playScreen], the specified Sub Screen is displayed from the start when the Base Screen is 
displayed on Web browser.

•	 When [InitialFrameTransition] is set to 'URL' and the 'URL' field is left blank, the space for Sub 
Screen is blank when the Base Screen is first displayed on Web browser.
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7.12  IP CAMERA DISPLAY FRAME

7.12.1  Appearance on the [Parts Box] window

The below figure shows an [IP Camera Display Frame] part allocated on a Base Screen.

Up to 3 [IP Camera Display Frame] parts can be allocated on one Screen. 
[IP Camera Display Frame] part cannot be displayed on Internet Explorer.

7.12.2  Function
[IP Camera Display Frame] is a part for displaying live video from an IP camera on the Base Screen.
Note that the IP camera must be able to obtain Jpeg images via HTTP(S) protocol.
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7.12.3  Parameter items
Click the [IP Camera Display Frame] part allocated on the Base Screen to display the [Property] window show-
ing parameter items to configure for obtaining live video.

	■ Layout

ITEM DESCRIPTION

Location
Specify the position from the range (0,0) to (3840,-3840).

X: �X coordinate of the left end of the part.
Y: �Y coordinate of the top end of the part.

Size
Specify the size of the part.

     Width: Max. size: 7680;  Min. size: 0
     Height: Max. size: 7680;  Min. size: 0

Note: Values protruding from the screen size can also set as Size and Location, but the protruded part may be not dis-
played at executing (browser-dependent).

* Variable by the screen size.  Max. 3840, 3840.

	■ [Common] Tab

ITEM DESCRIPTION

Name Enter an optional name for the [IP Camera Display Frame] part using up to 255 characters.
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	■ Camera

Configure parameters such as the format and Protocol for distributing the video.

ITEM DESCRIPTION

LiveMode  *1

Select the video format.

JPEG : Live video is obtained as JEG images.

STREAM : Live video is obtained as an H.264 stream

LiveProtocol  *2

Select the Protocol for distributing video from IP camera.

NONE : �Protocol Not specified. 
No live video is displayed.

HTTP : �Live video is obtained via HTTP. 
* Enabled when [LiveMode] is set as JPEG. 

HTTPS : �Live video is obtained via HTTPS. 
* Enabled when [LiveMode] is set as STREAM. 

RTSP+WS : �Live video is obtained over RTSP over Websocket. 
* Enabled when [LiveMode] is set as STREAM. 

RTSP+WSS : �Live video is obtained over RTSP over Websocket Secure. 
* Enabled when [LiveMode] is set as STREAM. 

LivePath  *2

Specify URI for distributing the live video from IP camera.

192.168.13.74:80/cgi-bin/camera?resolution=1280

Command and parameter for distribut-
ing live video  *2 

Port No. for distributing live video

IP address or domain name of IP 
camera

SendIntervalTime
Set the interval for obtaining live video in mseconds.
Setting range: 67 to 60000
* Enabled when [LiveMode] is set as JPEG.

*1  [STREAM] option is available for AXIS® IP cameras only.
*2  �Refer to the instruction manual of your IP camera for details. 

If the camera conforms to ONVIF (Open Network Video Interface Forum), these parameters can be automatically set 
with [Query by HTTP] button.  ➔"7.12.5 Camera Parameter Auto-Setting" on page 157 

	■ Communication

Click the [IP Camera Display Frame] part allocated on the Base Screen to display the [IPCameraFrame] win-
dow. ➔"7.12.4 IP Camera Display Frame Setting Window" on page 156 
[Communication] settings are required for obtaining parameters from IP camera.

ITEM DESCRIPTION

Host Enter IP address or domain name of IP camera.

Port Specify Port No. to be used for [Query by HTTP].
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7.12.4  IP Camera Display Frame Setting Window
Double-click the [IP Camera Display Frame] part allocated on the Base Screen to display the [IPCameraFrame] 
window. 
The parameters on this window respectively correspond to those on the [Property] window.
For details, refer to "7.12.3 Parameter items" on page 154.

CATEGORY ITEM PARAMETER NAME REMARK

Common Name Name

Communication
Host Host

Port Port

Camera

Live mode Live Type

Live protocol Protocol Auto-setting available.

Live video path Live Path Auto-setting available.

Port Port

Auto-setting available.
When Port No. for distributing 
live video is set to "-1", the value 
is specified based on the Live 
protocol. 

HTTP
RTSP+WS

: 80

HTTPS
RTSP+WSS

: 443

Update interval Interval

[Query by HTTP] button [Query by HTTP] 

Click the button to send a query for 
camera parameters via HTTP.

Clicking the button with pressing 
down [Ctrl] key sends the query via 
HTTPS. 
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7.12.5  Camera Parameter Auto-Setting
If the IP camera supports ONVIF (Open Network Video Interface Forum), camera parameters can be automati-
cally acquired by clicking [Query by HTTP] button on the [IPCameraFrame] window.

The procedure of auto-setting is as described below.

	■ Preparation

1)	 In prior to auto-setting, set the video profile (video settings such as resolution, encoding method, bit rate, 
etc.) for ONVIF using a setting tool of the IP camera.

2)	 Connect the PC on which RGP-Designer is running and the IP camera via Ethernet (or Wi-Fi) so as to com-
municate with each other.

Note)

•	 Consult the IP camera manufacturer for how to set the video profile for ONVIF.

•	 Most of ONVIF-compliant IP cameras have a pre-defined video profile. 
Configure or change the settings only if necessary.

	■ Procedure

1)	 Double-click the [IP Camera Display Frame] part allocated on the Base Screen to display the [IPCamera-
Frame] window. 

2)	 Enter the IP address or domain name in the [Host] field, specify the Port No., and select Live type. 
Set "-1" if the Com Port No. is unknown.

3)	 Click [Query by HTTP] to start query. 
If the IP camera supports HTTPS only, click [Query by HTTP] with pressing down [Ctrl] key to send query 
via HTTPS.

4)	 As the login dialog appears, enter user name and password and click [OK]. 
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5)	 Wait until the [Profiles] dialog showing a list of profiles appears. 
Select a profile from the list and click [OK].  

6)	 Confirm that the [IPCameraFrame] window shows the camera parameters, and click [OK].

	■ Query error

When a query error occurs, troubleshoot referring to the table below.

Error content Troubleshooting

"Failed to connect with remote server"
IP camera is powered-off.
Not connected with the network.
[Host] and/or [Port] settings are wrong. 

"Request failed with HTTP status 400" IP camera does not support ONVIF.

"Request failed with HTTP status 401: 
Unauthorized"

User name and/or password are wrong.

"The underlying connection was closed: 
An unexpected error occurred on a send"

IP camera closed the connection. 
Protocol may be wrong (try starting query with pressing down [Ctrl] key.

"Request failed with HTTP status 50: 
Service unavailable"
"Remote server returns error 503 Server 
Unavailable"

IP camera does not support ONVIF. 
IP camera is currently unavailable for receiving query. 
There may be problem with settings of router, proxy, or firewall.

No profile is shown on the [Profiles] 
dialog

No profile for ONVIF is set on IP camera. 
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7.12.6  IP Camera Display Frame Operation

[IP Camera Display Frame] part displayed on Web browser can be operated as described below. 

[IP Camera Display Frame] does not auto play. 
When the page on which the [IP Camera Display Frame] 
part is allocated is opened, only the frame is displayed as 
in the left figure.

Click inside the frame to display Play  and Pause  

buttons. 

Click      button to play live video. * 

Click inside the frame to display Play  and Pause  

buttons again.

Click  button to pause the video.

* �If authentication of IP camera is enabled, the browser 
will request user name and password. 
  

7.12.7  Cautions and Limitations
There are cautions and limitations to using [IP Camera Display Frame] as follows.

•	 Live video cannot be displayed on Internet Explorer.

•	 Live video which requires authentication cannot be displayed on iOS.

•	 [STREAM] option for Live Mode is available for AXIS® IP cameras only.

•	 When [STREAM] option is selected for Live Mode, video data is cached by each of IP camera and browser, 
which can cause video delay.  What is more, video flickers about once every ten minutes.

•	 When [JPEG] option is selected for Live Mode, a great amount of network bandwidth will be consumed. 
Set [SendIntervalTime] adequately longer, or set the resolution to a lower resolution on IP camera setting, if 
necessary.
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8.  SWITCH ACTION

8.1  OVERVIEW
RGP-Designer has a feature called switch actions. 

Switch action is a function of automatically changing data in the internal memory, etc. in accordance with an 
operation such as a mouse click performed on a part allocated on a Screen.

Switch actions include: 'BitOperation', 'WordOperation', 'ChangeBaseScreen', 'ChangeSubScreen', 'Displayedi-
alog', and 'CallCGI'.

For some parts, two or more switch actions can be executed with a single operation.

The table below shows switch actions to be executed by the respective parts.

PART NAME SWITCH ACTION NO. OF ACTIONS

Lamp/Switch

•	 Bit Operation
•	 Word Operation
•	 Change Base Screen
•	 Change Sub Screen
•	 Display Dialog
•	 Call CGI

Max. 8 actions with exceptions below: 
  Max. 1 Change Base Screen 
  Max. 3 Change Sub Screen 
  Max. 1 Display Dialog   

Change Base Screen •	 Change Base Screen 1 (fixed)

Change Sub Screen •	 Change Sub Screen 3 (fixed)

Display Dialog •	 Display Dialog 1 (fixed)
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8.2  REGISTER SWITCH ACTIONS
1)	 In order to register (set/edit) switch actions, double-click the Lamp or Switch allocated on Base Screen to 

display the [Lamp/Switch] window, and click the [Switch] tab.

NOTE

•	 When setting switch actions, make sure that the target part is allocated on the Base Screen, 
[Enable Switch] is checked on the [Common] tab, and the [Switch] tab is displayed on the 
[Lamp/Switch] window.

2)	 The below figure shows the initial state of the [Lamp/Switch] window.
Confirm that 'Bit Operation' is registered.
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3)	 Click the [Edit Action] button on the [Lamp/Switch] window to display the [Switch Action] setting window. 

As an example of switch action registration, 

4)	 Select 'Word Operation'.

5)	 Click [Add] button.

6)	� Confirm that 'Word Operation' is added to the Item list.
For details of settings of 'Word operation', refer to "8.4 WORD OPERATION" on page 166.
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8.3  BIT OPERATION
'Bit Operation' is an operation of causing the target [Lamp] or [Switch] part to turn ON/OFF, to invert, etc. when 
the part is clicked.  
The operation target is 1 bit of the RGP internal memory or 1 bit in address of a registered slave device.

Specify the location of the target bit and the expected operation when registering a 'Bit Operation'.

In order to register a 'Bit Operation', 

1)	 Select 'Bit Operation' on the [Switch Action] setting window.

2)	 Click [Add] button and confirm that 'Word Operation' is added to the Item list.
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8.3.1  Target Address setting
1)	 Click to select [TargetAddress] and click  at the right end of the row to display the [Device Address] dialog.

2)	 Check [Address].

3)	 Select the Slave No. to connect from the drop-down list.

4)	 Select the Device Name from the drop-down list.

5)	 Specify the Address.

6)	 Select the Bit position No.

7)	 Click [OK].

For details of the [Device Address] dialog, refer to "12. DEVICE ADDRESS" on page 192.
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8.3.2  Bit Action Type setting

1)	 On the [Switch Action] setting window, click to select [BitActionType] and select the action type from the 
drop-down list. 

2)	 Click [OK].

Bit Action Type DESCRIPTION

Set Writes '1' in the bit of [TargetAddress]. 

Reset Writes '0' in the bit of [TargetAddress]. 

Alternate Inverts the bit of [TargetAddress]. 

Momentary
Sets the bit of [TargetAddress] to '1' while the Switch is pressed. 
Returns the bit to '0', when the Switch is released.
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8.4  WORD OPERATION
'Word Operation' is an operation of causing data of the target [Lamp] or [Switch] part to be written, incremented/
decremented, etc. when the part is clicked.
The target is 1 word of the RGP internal memory or 1 word in address of a registered slave device.

Specify the location of the target word and the expected operation when registering a 'Word Operation'.

8.4.1  Word Action Type setting

1)	 On the [Switch Action] setting window, click to select [WordActionType] and select the action type from the 
drop-down list. 

WORD ACTION TYPE DESCRIPTION PARAMETER

Write Writes data in [TargetAddress] TargetAddress, Data

Copy Copies data of the source address to [TargetAddress] TargetAddress, SourceAddress

Increment

Increments data of [TargetAddress] by 1. 
When the data reaches the upper limit, returns the value 
to the lower limit value.

The upper limit and lower limit values differ depending 
on the data type of [TargetAddress].

TargetAddress

Decrement

Decrements data of [TargetAddress] by 1. 
When the data reaches the lower limit, returns the value 
to the upper limit value. 

The upper limit and lower limit values differ depending 
on the data type of [TargetAddress].

TargetAddress
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2)	 Specify the [TargetAddress] and [WriteValue].

3)	 Click [OK].

By the above settings, an operation of writing '30' in 'W/S0:GW6' (i.e. the 6th word of RGP internal device) is 
performed when the Switch is clicked.
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8.5  CHANGE BASE SCREEN
'Change Base Screen' is an operation of switching the Base Screen when a [Lamp] part, [Switch] part, or a 
[Change Base Screen] switch is clicked. 

8.5.1  Parameter Settings
[DisplayScreen] is the only parameter item to configure for [Change Base Screen].

1)	 Select which Base Screen to switch to.

2)	 Click [OK]. 
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8.6  CHANGE SUB SCREEN
'Change Sub Screen' is an operation of displaying a Sub Screen when a [Lamp] part, [Switch] part, or a [Change 
Sub Screen] switch is clicked. 

External contents can be displayed on the Sub Screen by selecting 'NavigateByURL' as [ScreenTransition-
Method] and specifying the URL of the contents.

8.6.1  Parameter Settings
Edit the parameter values referring to the table below.

ITEM DESCRIPTION REMARKS

DisplayScreen Select a Sub Screen to display. –

Scale
Specify the display scale (ratio) of contents within the frame.
Setting range: 0.5 to 1.0

Default: 1.0

ScreenTransitionMethod

ChangeScreen: �Displays the Sub Screen specified as [Dis-
playScreen].

NavigateByURL: �Displays external contents of the specified 
URL.

Default: ChangeScreen

TargetFrame(Frame)
Select the Sub Screen Frame in which to display the Sub 
Screen.

–

Note: In order to display the information about the power measuring devices on RGP30-W sub screen, specify 
'NavigateByURL'.
For details, refer to Users Manual of RGP30-W (EM-8581-D). 
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8.7  SHOW DIALOG
'Show Dialog' is an operation of displaying a Dialog Screen when a [Lamp] part, [Switch] part, or a [Show Dialog] 
switch is clicked. 

8.7.1  Parameter Settings
Edit the parameter values referring to the table below.

ITEM DESCRIPTION REMARKS

DisplayScreen Select the screen to display as Dialog Screen. –

Scale
Specify the display scale (ratio) of contents within the frame.
Setting range: 0.5 to 1.0

Default: 1.0

TargetFrame Select the Dialog Frame in which to display the Dialog Screen. –
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8.8  CLOSE DIALOG
'Close Dialog' is a switch action of closing the Dialog Screen and can be registered only to a switch allocated on 
the Dialog Screen.

8.8.1  Parameter Settings
'Close Dialog' has no parameter to configure.
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8.9  CGI CALL
'CGI Call' is an operation of transmitting an operation command to CGI-compatible devices.

8.9.1  Parameter Settings

Edit the parameter values referring to the table below.

ITEM SETTING REMARKS

HttpMethodType
GET GET method is used to invoke a CGI command.

POST POST method is used to invoke a CGI command.

ParameterString Character string Parameter for CGI command (QueryString)

Uri Character string URL for CGI command

	■ Parameter Setting Example: For zooming in with an Axis IP camera

ParameterString: without

ITEM SETTING VALUE

HttpMethodType GET or POST (Axis supports both methods)

ParameterString Blank

Uri http://192.168.13.73/axis-cgi/com/ptz.cgi?zoom=999&camera=1

ParameterString: with

ITEM SETTING VALUE

HttpMethodType GET or POST (Axis supports both methods)

ParameterString zoom=9999&camera=1

Uri http://192.168.13.73/axis-cgi/com/ptz.cgi



173
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

9.  TRIGGER AND TRIGGER ACTION

9.1  OVERVIEW
Trigger and trigger action are a function of executing a specified movement (trigger action) automatically by an 
event (trigger) which is assigned to a GP folder or Base Screen.

Specifically, trigger and trigger action are used for switching between screens at a certain cycle, at the desig-
nated time, or when the designated bit turns ON. 

9.2  TRIGGER
Trigger is the definition of the start of executing a trigger action.   ➔ "9.3 TRIGGER ACTION" on page 176
Trigger is an attribute of Folder property or Base Screen property.
Upon generation of the set trigger, the trigger action associated with the trigger is executed.

9.2.1  Trigger conditions
Trigger conditions are as described in the table below.

TRIGGER TYPE FOLDER BASE SCREEN ACTION

OnCycle
✓ ✓ Trigger is generated at intervals of time (seconds) 

designated in the [Interval] field. 

OnTime

✓ ✓ Trigger is generated at the time designated in the [Trig-
gerTime] field.

Ex) �Set to "13:20:05" to generate the trigger every day 
at 13 o'clock 20 minutes 5 minutes. 

OnBit

✓ ✓ Trigger is generated when the bit address designated 
in the [TriggerAddress] field turns ON.

When the [TurnoffTriggerAddress] is set as True, the 
set bit address is reset to OFF before executing the 
trigger action.

Note: �Expression symbols cannot be used as [Trig-
gerAddress].
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9.2.2  Trigger Setup
Trigger settings can be configured from the [Triggers] field on the [Property] window of GP Folder or Base Screen.
Click to select the [Triggers] field and click [···] at the right of the field to display the [Triggers] Collection Editor 
window.
Add, delete, or edit triggers on this window.

FOLDER PROPERTY BASE SCREEN PROPERTY
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9.2.3  Configuration on [Triggers] Collection Editor

	■ How to configure

Configure triggers referring to the table below.

ITEM DESCRIPTION

Type
Select the trigger type. 
Refer to "9.2.1 Trigger conditions" on page 173 for details of trigger types.

Member List of registered triggers.

[Add] button
Click the button to add the trigger designated as [Type] to [Member].
Up to 8 triggers can be registered.

[Delete] button Click the button to delete the selected trigger from [Member].

	■ Parameter items

Click to select a trigger from the list of [Member] to display parameter items under the [Property].

ITEM DESCRIPTION

Actions

Configure a list of trigger actions to be executed when a trigger is generated.
Click to select the [Actions] field and click [···] at the right of the field to display 
the [Actions] Collection Editor window.
Add, delete, or edit trigger actions on this window.

Interval
Set the generation interval of trigger in seconds.  
Setting range: 00:00:00 to 23:59:59
* This parameter is available only when [Type] is set to OnCycle.

TriggerTime
Set the time at which the trigger is generated in HH:MM:SS format. 
Setting range: 0 to 600
* This parameter is available only when [Type] is set to OnTime.

TriggerAddress
Set the Bit address to monitor. 
The trigger is generated when this Bit turns ON.
* This parameter is available only when [Type] is set to OnBit.

TurnoffTriggerAddress
Specify whether to reset the Bit of the set [TriggerAddress].
When the OnBit trigger is generated, the Bit is reset to OFF.
* This parameter is available only when [Type] is set to OnBit.
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9.3  TRIGGER ACTION
Trigger action is the definition of action to be executed when the trigger is generated.
In this version of RDP-Designer, only ChangeScreen action (set to GP folder) and ChangeSubScreen Action 
(set to Base Screen) are available.

9.3.1  Trigger action type
Trigger action types are as described in the table below.

Action type Trigger set to Folder Trigger set to Base Screen Action

ChangeScreen ✓ –

Shifts to the page designated in the [Dis-
playScreen] field.

When [DisplayScreen] is blank, shifts to the 
page designated in the [NextScreen] field 
of the property of the currently displayed 
Base Screen.
If [NextScreen] field is also blank, this ac-
tion is ignored.

ChangeSubScreen – ✓

Displays the Sub Screen of the Sub 
Screen Frame designated in the 
[TargetFrame(Frame)] field on the Screen 
designated in the [DisplayScreen] field
at the set [Scale].

When [DisplayScreen] is blank, shifts to the 
Screen designated in the [NextScreen] field 
of the property of the currently displayed 
Base Screen. 
If [NextScreen] field is also blank, this ac-
tion is ignored. 

9.3.2  Trigger action setup
Trigger actions can be added, deleted, or edited on the [Actions] Collection Editor window.

Click to select the [Actions] field on the [Triggers] Collection Editor window, and click [···] at the right of the field 
to display the [Actions] Collection Editor window. 

Click to select a trigger action from the list of [Member] to display parameter items under the [Property].
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9.3.3  Configuration on [Actions] Collection Editor

	■ How to configure

Configure triggers referring to the table below.

ITEM DESCRIPTION

Type
Select the trigger action type. 
Refer to "9.3.1 Trigger action type" on page 176 for details of trigger action 
types.

Member List of registered trigger actions.

[Add] button
Click the button to add the trigger action designated as [Type] to [Member].
Only 1 trigger action can be registered.

[Delete] button Click the button to delete the selected trigger action from [Member].

	■ Parameter items

Click to select a trigger action from the list of [Member] to display parameter items under the [Property].

ITEM DESCRIPTION

DisplayScreen Specify the Bas Screen or Sub Screen to switch to.

TargetFrame(Frame)
Specify the Sub Screen Frame subject to ChangeSubScreen Action.
* This parameter is available only when [Type] is set to ChangeSubScreen.

Scale
Set the scale of displaying Sub Screen in the range of 0.5 to 1.0.
* This parameter is available only when [Type] is set to ChangeSubScreen.



178
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

10.  SYSTEM SYMBOLS

10.1  OVERVIEW
System symbols are special variables which are defined in the RGP unit, and can be used where Device address 
can be used.

NOTE

•	 System symbols are available for RGP30-N2 (v1.1. or later), RGP30-W and RGP6-N2 (v1.1 
or later) only.

•	 If your RGP unit is RGP30-N or RGP-6, update the firmware to enable System symbols.

10.2  SYSTEM SYMBOL TYPES

SYMBOL TYPE ACCESS TYPE ATTRIBUTE DESCRIPTION

\SW\COUNTER I16_U16 Read/Write

Internal counter which counts up every 100 
msec.
The count starts when the page is dis-
played.
Counting range: 0 to 32767

\SB\COUNTER00
|

\SB\COUNTER15
Bit Read/Write Represents each Bit of \SB\COUNTER.

\SB\ALWAYSOFF Bit Read Always OFF Bit.

\SB\ALWAYSON Bit Read Always ON Bit.

\SW\REBOOT I16_U16 Read/Write
Write "1" to start the RGP unit.
Reading is enabled but the read value has 
no meaning.

\SW\SHUTDOUN I16_U16 Read/Write
Write "1" to shut down the RGP unit.
Reading is enabled but the read value has 
no meaning.

Note: Writing using system symbols is enabled only when HTTPS protocol is used.
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11.  EXPRESSIONS

11.1  OVERVIEW
Numeric expressions can be user-defined and used as symbol variables.

11.2  EDITING EXPRESSIONS
Expressions can be edited by the following procedure.

	■ Procedure

1)	 Select [Expression Settings(E)] from Tool menu or Tool bar to display the [Symbol Settings] window. 

2)	 Edit parameter items referring to the table below.

ITEM DESCRIPTION

Symbol Name
Enter an optional name.
* �For prohibited characters and character codes, refer to "16.1 PROHIBITED 

CHARACTERS" on page 210.

Access Type

Specify the data type for the expression result. 
This parameter setting is applied only to the result and not to the operations of 
expression.

Ex) 
Access Type: I16_U16 (16 bit integer)
Expression: 1.423 * 2.900
Result (wrong): 1 * 3 = 3 (converted to integer before calculation)
Result (correct): 1.423 * 2.900 = 4.127 ➔ 4 (converted to integer after calcula-
tion)
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ITEM DESCRIPTION

Expression

Enter an expression using up to 255 characters.
Double-click the cell to display the [Expression Editor] window which facilitates the 
entry of expression.
For details, refer to "11.4 EXPRESSION EDITOR" on page 189

Comment
Enter a description for the symbol variable using up to 255 characters.
This parameter item is optional and can be left blank.

3)	 Click [OK] to save the expressions.

11.3  EXPRESSION SPECIFICATIONS
Expressions must be described in accordance with the specifications as shown in the table below.

ITEM DESCRIPTION

Operator Allowable operator type: binary operators only.

Associativity / Precedence 
Associativity and operator precedence must follow the rules of JavaScript.
Refer to: ECMAScript https://tc39.es/ecma262/#sec-multiplicative-operators

Operator description
Descriptions of operators are unique to RGP-Designer and may be different from those 
of JavaScript. 

Length Define an expression using 1 to 255 characters.

Data type
Expression result has the same Data type as that of Device Address i.e., Bit, (U)Int8, (U)
Int6, (U)Int32, or Float. 

Internal representation
Expressions are represented internally as double-precision floating-point values.
Note that (1/3)*3 may not necessarily be 1, for example.

Error representation

When a result cannot be represented as a numerical value, either of the following con-
stants is used to represent the result.

NaN   : �Result is indeterminate or erroneous. 
Ex)  0/0

Infinity: �Result is indefinite. 
Ex) 1/0

Usable elements

Elements which can be used in expressions are as follows.

Element Description

Literal values : �Real values such as 1, 0.25, etc. 
Setting range: -10000000000 to 10000000000

Constants / 
internal variables

: Constants or variables defined in RGP-Designer.

Symbol variables : �Symbol variables pre-defined on the [Symbol Settings] window.
Note)
- Symbol variable must be enclosed in parenthesis [ ] .
- �Expression symbols are not allowed as they can cause circu-

lar reference.

Functions : Built-in function defined in RGP-Designer.
Note)
- Buil-in function must take at least one argument.
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	■ Elements and Descriptions

ELEMENT DESCRIPTION EXAMPLE

Literal Actual value
200
-1.23

Parenthesis
Used to control the order of operations in the 
expression.

(20-100)/PI

Symbol

System symbol or a symbol assigned to Device 
Address. 
Symbol must be enclosed in parenthesis. 
  �Note) 
- Expression symbols cannot be used.

[PRODUCTION Q'TY]*[/SW/COUNTER]

Constant Pre-defined constant 2*PI/[RADIUS]

Internal variable Pre-defined variable DD + 1

Built-in function
Pre-defined built-in function
  �Note) 
- �Built-in function must take at least one argument.

ABS([PRODUCTION Q'TY] - [DEFECTIVE Q'TY])

11.3.1  Operator types
Table below shows the operations which can be used in expressions.

NOTATION FUNCTION
NOTATION IN 

JavaScript
DESCRIPTION

^ Exponentiation ** or Math.pow(x,Y) *4

* Multiplication * *4

/ Division / *4

% Surplus count % *4

+ Addition +

- Subtraction -

LSHIFT Left shift << Shift bit to the left regardless of sign.

RSHIFT Right shift >> Shift bit to the right regardless of sign.

< Less than < Comparison operator  *1

> Greater than > Comparison operator  *1

<= Less than or equal <= Comparison operator  *1

>= Greater than or equal >= Comparison operator  *1

!= Inequality != Comparison operator  *1

== Equality == Comparison operator  *1

& Bitwise AND & Bit operator  *2

XOR Bitwise XOR ^ Bit operator  *2

| Bitwise OR | Bit operator  *3

&& Logical AND && Boolean operator  *3

|| Logical OR || Boolean operator  *3

*1  Result of comparison operation; false: 0, true: 1
*2  Operation is performed on each bit.  Only the integral part is evaluated for a floating point value.
*3  Result is false: 0, true: other than 0.
*4  Signed literal value described in the right term of an operator must be enclosed parenthesis. (i.g. 1*(-2)).
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11.3.2  Constant values and Internal variables
Table below shows the operations which can be used in expressions.

	■ Constant values

NOTATION FUNCTION DESCRIPTION

PI Pi
Corresponds to Math.PI in JavaScript.
3.141592653589793

E Base of the natural logarithm 
Corresponds to Math.E in JavaScript.
2.718281828459045

	■ Internal variables

NOTATION FUNCTION DESCRIPTION

PAGE Page number Page number of the Screen currently being displayed.

DY Year Year of the current time and date. *

DM Month Month of the current time and date. 

DD Day Day of the current time and date.

DW Day of week
Day of the week of the current time and date.
  0: Sunday to 6: Saturday

TH Hours
Hours of the current time and date.
  0 to 23

TM Minutes Minutes of the current time and date.

TS Seconds Seconds of the current time and date

TL Milliseconds Milliseconds of the current time and date.

*  The allowable range of current time and date (year) depends on the user's system.
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11.3.3  Built-in functions
RGP has the following pre-defined built-in functions.

	■ ABS

NOTATION ABS(x)

FUNCTION Returns the absolute value of Argument x.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to Math.abs in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0

	■ ROUND

NOTATION ROUND(x)

FUNCTION Returns the value obtained by rounding Argument x.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to Math.round in JavaScript.
Returns one of the following values when Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0

	■ FLOOR

NOTATION FLOOR(x)

FUNCTION Returns the value obtained by truncating Augment x to an integer.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to Math.floor in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0
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	■ CEIL

NOTATION CEIL(x)

FUNCTION Returns the value obtained by rounding up Argument x to an integer.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to Math.ceil in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0

	■ RANDOM

NOTATION RANDOM(x)

FUNCTION Returns a random value among 0 and values smaller than Argument x.

ARGUMENT Numerical value greater than 0.

DESCRIPTION

Corresponds to Math.random in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : undefined

NaN : undefined

Infinity : Infinity

null : undefined

	■ SIN

NOTATION SIN(x)

FUNCTION Returns the sine of Argument x.

ARGUMENT Numerical value (radian)

DESCRIPTION

Corresponds to Math.sin in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : NaN

null : 0
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	■ COS

NOTATION COS(x)

FUNCTION Returns the cosine of Argument x.

ARGUMENT Numerical value (radian)

DESCRIPTION

Corresponds to Math.cos in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : NaN

null : 1

	■ TAN

NOTATION TAN(x)

FUNCTION Returns the tangent of Argument x.

ARGUMENT Numerical value (radian)

DESCRIPTION

Corresponds to Math.tan in JavaScript.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : NaN

null : 0

	■ LOG

NOTATION LOG(x)

FUNCTION Returns the natural logarithm (base e) of Argument x.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to Math.log in JavaScript.
Always returns NaN when x is a negative value.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : -Infinity
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	■ LOGB

NOTATION LOGB(x)

FUNCTION Returns the logarithm (base 2) of Argument x.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to the following expression in JavaScript.
  Math.log(x)/Math.LN2

Always returns NaN when x is a negative value.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : -Infinity

	■ LOGD

NOTATION LOGD(x)

FUNCTION Returns the logarithm (base 10) of Argument x.

ARGUMENT Numerical value

DESCRIPTION

Corresponds to the following expression in JavaScript.
  Math.log(x)/Math.LN10

Always returns NaN when x is a negative value.
Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : -Infinity

	■ RAD

NOTATION RAD(x)

FUNCTION Converts Argument x from degree to radian.

ARGUMENT Numerical value (degree)

DESCRIPTION

Corresponds to the following expression in JavaScript.
  x*Math.PI/180

Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0
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	■ DEG

NOTATION DEG(x)

FUNCTION Converts Argument x from radian to degree.

ARGUMENT Numerical value (radian)

DESCRIPTION

Corresponds to the following expression in JavaScript.
  x*180/Math.PI

Returns one of the following values when the Argument is other than numerical value.

undefined : NaN

NaN : NaN

Infinity : Infinity

null : 0

	■ NOT

NOTATION NOT(x)

FUNCTION Returns the logical negation of Argument x.

ARGUMENT
Numerical value
Note)
 - Value other than 0 is regarded as true and operation is processed.

DESCRIPTION

Corresponds to the following expression in JavaScript.
  (!(x)?1:0)

Returns one of the following values when the Argument is other than numerical value.

undefined : 1

NaN : 1

Infinity : 0

null : 1

	■ SINWAVE

NOTATION SINWAVE(x) 

FUNCTION Returns a sine wave (-1 to 1) whose period is Argument x (seconds).

ARGUMENT
Numerical value
1 to 32767

DESCRIPTION

Time start point is when the page is loaded.
 Returns one of the following values when the Argument is other than numerical value.

undefined : undefined

NaN : undefined

Infinity : undefined

null : �Operation is processed as 1 second.
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	■ RCTWAVE

NOTATION RCTWAVE(x)

FUNCTION Returns a rectangular wave (-1 to 1) whose period is Argument x (seconds).

ARGUMENT
Numerical value
1 to 32767

DESCRIPTION

Time start point is when the page is loaded.
 Returns one of the following values when the Argument is other than numerical value.

undefined : undefined

NaN : undefined

Infinity: : undefined

null : �Operation is processed as 1 second.

	■ SAWWAVE

NOTATION SAWWAVE(x)

FUNCTION Returns a sawtooth wave (-1 to 1) whose period is Argument x (seconds).

ARGUMENT
Numerical value
1 to 32767

DESCRIPTION

Time start point is when the page is loaded.
 Returns one of the following values when the Argument is other than numerical value.

undefined : undefined

NaN : undefined

Infinity: : undefined

null : �Operation is processed as 1 second.

	■ COUNTER

NOTATION COUNTER(x)

FUNCTION Returns the count of 100 Milliseconds from the time when the page is loaded.

ARGUMENT

Numerical value
0 to 15
Returns the value of the specified bit of the count value as 1/0.
Other than the above, returns the count value as is. 

DESCRIPTION

Time start point is when the page is loaded.
Note)
 - Symbol variable: /SW/COUNTER has the same effect as this function.
 - The counter is reset every time the page is switched.

 Returns one of the following values when the Argument is other than numerical value.

undefined : Returns the count value as is. 

NaN : Returns the count value as is. 

Infinity: : Returns the count value as is. 

null : Returns the count value as is. 
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11.4  EXPRESSION EDITOR
Expressions can be entered directly to the table on [Expression] tab of the [Symbol Settings] window.
Alternatively, click the cell of expression on the table to display the [Expression Editor] window for ease of ex-
pression entry.

Expression pane

No. of characters

11.4.1  Parameter items

ITEM DESCRIPTION RESTRICTION

Expression pane Enter an expression.

Expression must consist of 1 to 255 characters.
Refer to "11.3 EXPRESSION SPECIFICATIONS" 
on page 180 for details of grammar of expres-
sions.

Number of characters
No. of currently entered characters / 
Allowable No. of characters
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11.4.2  Input Assist
[Expression Editor] has a function of assisting construction of expressions.

	■ Symbol Input Assist

[Expression Editor] assists entry of symbols.

1)	 Enter a square bracket to display Symbol Input Assist.

2)	 Confirm that a drop-down list of candidates, i.e., device symbols and system symbols is displayed. 
The list does not include expression symbols as they cannot be used for expressions.

3)	 Select a symbol from the list, perform key/button operation, and close the [Expression Editor] window refer-
ring to the table below.

KEY/BUTTON OPERATION FUNCTION

Pressing [Enter] Applies the candidate to the Editor.

Double-clicking a candidate Applies the candidate to the Editor.

Entering ] Applies the candidate to the Editor.

Pressing [Esc] key Ignores the candidate and displays [ only.

Clicking on the Expression pane Ignores the candidate and displays [ only.

Clicking [OK]
Closes the Editor if the candidate is applied properly.
"Syntax errors" message will be displayed when no candidate is applied 
and only [ is displayed.

Clicking [Cancel] Ignores the candidate and closes the Editor.
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	■ Element input assist

[Expression Editor] assists entry of operators and built-in functions.

1)	 Right-click the Editor pane to display a context menu showing a list of usable elements.

2)	 Point each element menu to display a brief description of the element.

3)	 Select an element and confirm that the element is inserted to the cursor position or the selected area in the 
Editor pane.
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12.  DEVICE ADDRESS

12.1  OVERVIEW
RGP and RGP-Designer employ Device Addresses each of which is an identifier assigned to a relay, register, or 
memory of external device such as PLC.
This identifier consists of Data type and Slave number which do not depend on the model of the slave device.

Shown below is an example of Device Address.

W / S1 : DO
(1)      (2)       (3)

(1)	 Data type

	 Indicates one of the following data types.

ITEM DATA TYPE

B 1 Bit

H Signed 8-bit integer, Unsigned 8-bit integer

W Signed 16-bit integer, Unsigned 16-bit integer

L Unsigned 32-bit integer

F Single precision floating point (32-bit)

(2)	 Slave number

	 Indicates a slave number (S1 to S32) shown on the [Project Explorer] window.

(3) Device name and address
Indicates a device name and an address number.
For details, refer to "15.4 DEVICE LIST" on page 204.
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12.2  PARAMETER ITEMS FOR DEVICE ADDRESS
Device address as an operation target can be specified easily on the [Device Address] dialog.

The [Device Address] dialog is opened by clicking, for example, the [Monitor Address] field on the [Property] 
window of a part, the [Target Address] field on the [Lamp/Switch] window, or the [Device Address] field on the 
[Symbol Settings] window.  

Configure the parameter values referring to the table below for specifying the Device Address.

 

ITEM DESCRIPTION REMARKS

Address tab
The method of setting Device Address by 
specifying [Connect Driver], [Device Name], 
and [Address].

–

Symbol

Device Address is specified by selecting a 
symbol variable from the symbol variables 
set in advance.

Symbol variables can be used instead of the 
actual Device address.
For details, refer to 3.4 TOOL MENU > 
"3.4.7  Symbol Settings(S) and Expression 
Settings(E)" on page 40.

Connect Driver 
(Slave device)

Select from:
S0: RGP internal device *1; and  S1 to S32 
(only the registered slave device numbers 
appear on the drop-down list).

For details of slave registration, refer to 3.8 
PROJECT EXPLORER WINDOW > "3.8.2 
Slave" on page 54.

Device Name
Device name corresponding to [Connect 
Driver] is displayed.

For details of device names, refer to "15.4 
DEVICE LIST" on page 204.

Address
Set the Address number of the Slave device. 
For a Bit Device, specify the Bit position from 
0 to 15.

–

Filter

Select an option to filter the drop-down list on 
the [Symbol] tab.

Option Displayed symbols

All All usable symbols

Device Symbols assigned to the inter-
nal device or external devices

System Symbols assigned to special-
ized internal memory of RGP 
unit

Expression Symbols assigned to expres-
sions

–

*1  For details of RGP internal device, refer to "15.3.1 Common internal device" on page 203.
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13.  INTERLOCK FUNCTION

13.1  OVERVIEW

RGP unit is equipped with a simplified interlock function, which is implemented by software.

We do not guarantee correct operation of the interlock function when a problem such as network device error, 
communication error, etc. occurs.

We strongly recommend the user to build your system with interlock control using physical I/O devices which 
function as safety instrumentation.
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13.2  FUNCTION
1)	 Enable or disable the Interlock function on the [Switch] tab of the [Lamp/Switch] window.

2)	 When [Enable Interlock] is checked, confirm that the fields for specifying the Bit and the interlock condition 
appear.

<--- Specify Bit

<--- Select Interlock Condition

3)	 Specify the Bit on the [Device Address] dialog.  

						       ➔ "12. DEVICE ADDRESS" on page 192

4)	 Select the Interlock Condition between 'Hi' and 'Lo(Low)'.

By this setting, the Switch is disabled when the specified Bit meets the set Interlock Condition.
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14.  FIGURE

14.1  OVERVIEW
The Figure or appearance of a [Lamp] or [Switch] part can be changed by configuring image, text, display posi-
tion of the text, color, etc.

NOTE

•	 When both [Enable Lamp] and [Enable Switch] are checked, edit parameter values on the 
[Lamp] tab as the parameter are grayed out on the [Switch] tab as shown below. 
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14.2  PARAMETERS FOR FIGURE
Edit the parameter values for specifying the figure of the part referring to the table below.

ITEM DESCRIPTION REMARKS

BackgroundColor
Set the background color of the part.
Click to display [Select Color] dialog.  *1

The dialog may look different depending on OS.

FontColor
Set the font color of the text to be displayed 
on the part.
Click to display [Select Color] dialog. 

The dialog may look different depending on OS.

BorderColor
Set the border color.
Click to display [Select Color] dialog. 

The dialog may look different depending on OS.

BorderWidth
Set the border width. 
Range: 0 to 10 (pixels)

–

TextAlign
Set the text align to:  
'Left', 'Center', or 'Right'.

–

Text
Set text to be displayed on the part using
0 to 80 characters.

–

Font
Set the font for text. 
Click to display [Font] dialog.  *2

The dialog may look different depending on OS.

Icon
Set an image to display as the part. 
Double-click the image of the part to dis-
play [Select Image] dialog. 

The dialog may look different depending on OS.

Blink

Set '�Blink' / 'Heartbeat' as display status. 
Normal     : Static display 
Blink         : Blinking 
Heartbeat : Heart-beating 
Both          :Blinking & heart-beating

–

Copy

Click [Copy] to display [Copy Figure] dialog. 
Check the destination to copy to, and 
click [OK] to reflect the set values on the 
destination.

–
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*1  �In order to make the background transparent, manually enter '0, 255, 255, 255' in the [BackgroundColor] field on the 
[Property] window. 
Go to [Figure] and select '0' or '1' to display [BackgroundColor] when the Monitor Type is Bit, or select '0' to '15' when 
the Monitor Type is Word.

*2  �Due to the specifications of Windows, the font size will be 9.75 pt even when set to 10 pt. 
The upper limit of Font size is 240 pt.
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15.  MASTER-SLAVE COMMUNICATION
In this section, registration of slave devices to be connected with RGP unit and types of devices of the slave 
devices will be explained.

A maximum of 32 slave devices can be connected to a single RGP unit.

15.1   COMMUNICATION WITH SLAVE DEVICES

15.1.1  Register slave devices
Slave devices are assigned to respective slave numbers (S1 to S32).
Configure each slave device assigned to a slave number (Sx) on RGP-Designer.

RGP unit has a virtual device in the internal memory, which is preregistered as 'S0'.
For details of the internal memory, refer to "15.3 COMMON INTERNAL DEVICE" on page 203.

ITEM DESCRIPTION

Max. No. of slave devices 32

Slave No. S1 to S32

Common parameter items •	 IP Address
•	 Protocol (Modbus/TCP or SLMP)

Modbus/TCP parameter items

•	 Port No. (0 to 65535  default: 502)
•	 Unit ID (0 to 255  default: 1)
•	 Timeout (1 to 10 sec.  default: 1 sec.)
•	 Frame size (256; fixed)
•	 Driver (depends on each slave device or the standard Modbus/TCP driver)

SLMP parameter items

•	 Port No. (0 to 65535  default: 8192)
•	 Network No. (0 to 255  default: 0) *1

•	 Station No. (1 to 255  default: 255) *2

•	 Processor No. (0 to 65534  default: 1023) *3

•	 Timeout (1 to 10 sec.  default: 1 sec.)
•	 Driver (MELSEC Q/ iQ-R/ iQ-F)

*1  Basically, set to '0' in decimal.
*2  Basically, set to '255' in decimal.
*3  Basically, set to '1023' in decimal.



200
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

15.1.2  Modbus/TCP
The table below shows Modbus function codes supported by RGP-Designer.

CODE REGISTER TYPE DESCRIPTION

01 Read Coil Status Reads the ON/OFF status of a single or multiple coils.

02 Read Input Status Reads the ON/OFF status of a single or multiple inputs.

03 Read Holding Register Reads the value(s) of a single or multiple holding registers.

04 Read Input Register Reads the value(s) of a single or multiple input registers.

05 Force Single Coil Writes a value (ON/OFF) in a single coil.

06 Preset Single Register Presets a value in a single holding register.

15 Force Multiple Coils Writes a value (ON/OFF) in each of multiple coils.

16 Preset Multiple Registers Presets values in respective multiple holding registers.

The table below shows devices assigned to Modbus/TCP-compatible slaves.

ITEM DESCRIPTION

Device Address 1 to 65536

Bit Device
Input   : Coil (0X), Input (1x)
Output: Coil (0X)

Word Device
Input   : Input Register (3X), Holding Register (4X)
Output: Holding Register (4X) 
(Bit-access allowed)

Long-word Device
Input   : Input Register (3X), Holding Register (4X)
Output: Holding Register (4X) 
(Two devices connectable; upper and lower registers invertible; Bit-access allowed)

Float Device
Input   : Input Register (3X), Holding Register (4X)
Output: Holding Register (4X) 
(Two devices connectable; upper and lower registers invertible)

Device to be connected

Yokogawa Electric
FA-M3 Sequence CPU Module (F3SP71/-4S, F3SP76/-7S)

Mitsubishi Electric
Modbus/TCP Interface Module (QJ71MT91)

Our devices
- Web Data Logger (DL30-N, DL8)
- Paperless Recorder (TR30-G)
- Remote I/O (R3-NE1, R7E series, R9EWTU, R6-NE1, R6-NE2, R5-NE1, R30-NE1)
- D3/D5 series Interface module (D3-NE1, D3-NE2, D5-NE1)
- Wireless Gateway (IB10W2(4), WL40EW2, ITxSW5)
- Ethernet Communication Adaptor (72EM2-M4, GR8-EM)
- Tower Light IT series
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15.1.3  SLMP
The table below shows commands and devices assigned to SLMP-compatible slaves.

ITEM DESCRIPTION

Protocol TCP (UDP not supported)

Code Binary (ASCII not supported)

Command Read, Read Random, Write Random 

Device
SM, SD, X, Y, M, L, F, V, B, D, W, TS, TC, TN, LTS, LTC, LTN, STS, STC, STN, LSTS, 
LSTC, LSTN, CS, CC, CN, LCN, SW, Z, LZ, R, ZR, RD
(Bit-access allowed)

Device to be connected Mitsubishi Electric MELSEC Q, iQ-R, iQ-F series

Device Address is represented in decimal (e.g. D, M) or in hexadecimal (e.g. X, Y) depending on the type of 
Device.

For details, refer to 'SLMP Reference Manual" of Mitsubishi Electric.

Convert the Device Address represented in hexadecimal into decimal when setting the address on RGP-Design-
er.

	■ SLMP-compatible devices that can be connected to RGP unit

•	 MELSEC iQ-R Series CPU units (Mitsubishi Electric)

•	 MELSEC iQ-F Series CPU units (Mitsubishi Electric)

•	 MELSEC Q Series CPU units (Mitsubishi Electric)

(Tested and verified)

•	 R04CPU

•	 FX5U-32M

•	 Q03UDECPU
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15.2  ACCESS TYPE

15.2.1  Data Type
The table below shows the data types of the devices.

The data types of devices of slaves connected to RGP unit are predefined.

ITEM DATA TYPE

Bit 1 Bit

I8 Signed 8-bit integer

U8 Unsigned 8-bit integer

I16 Signed 16-bit integer

U16 Unsigned 16-bit integer

I32 Signed 32-bit integer

U32 Unsigned 32-bit integer

Float Single precision floating point (32-bit)
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15.3  COMMON INTERNAL DEVICE

15.3.1  Common internal device
RGP unit has a virtual slave No. S0 defined in the internal memory so that the user can freely use its devices 
(memory area).

The device assigned to Slave No. S0 is reset to 0 when RGP unit is started and a Project is transferred to the 
RGP unit.

Note that data is not retained when power supply is interrupted.

Slave No. S0 operates as an internal device which is commonly used among Graphic Panels GP1 to GP8.

The table below shows devices of the virtual slave.

ITEM NO. OF BITS RANGE

Bit Device 1 GB0 to 9999

Word Device 
16 GW0 to 9999

(Bit-access allowed)

Long-word Device
32 GL0 to 9999

(Bit-access allowed)

Float Device 32 GF0 to 9999
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15.4  DEVICE LIST
The tables below show details of devices of respective slaves.

15.4.1  RGP

The table below shows devices of RGP unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

GB 1 0 to 9999 R/W --- Bit

GW 16 0 to 9999 R/W --- Bit, I16, U16

GL 32 0 to 9999 R/W --- Bit, I32, U32

GF 32 0 to 9999 R/W --- Float

15.4.2  Modbus/TCP
The table below shows devices of general Modbus/TCP devices.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

0X 1 1 to 65536 R/W --- Bit, I8, U8, I16, U16, I32, U32

1X 1 1 to 65536 R --- Bit, I8, U8, I16, U16, I32, U32

3X 16 1 to 65536 R LE Bit, I8, U8, I16, U16, I32, U32, Float

4X 16 1 to 65536 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

3X(S) 16 1 to 65536 R BE Bit, I8, U8, I16, U16, I32, U32, Float

4X(S) 16 1 to 65536 R/W BE Bit, I8, U8, I16, U16, I32, U32, Float

15.4.3  DL8 (Modbus/TCP)
The table below shows devices of DL8 unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

AI 16 1 to 32 R --- Bit, I16, U16

DI 1 1 to 64 R --- Bit, I16, U16

PI 32 1 to 32 R --- Bit, I32, U32, Float

CI *1 32 1 to 64 R --- Bit, I32, U32

AO 16 1 to 32 R/W --- Bit, I16, U16

DO 1 1 to 64 R/W --- Bit, I16, U16

*1 CI: Counter of DI
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15.4.4  DL30 (Modbus/TCP)
The table below shows devices of DL30 unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

AI 16 1 to 128 R --- Bit, I16, U16

DI 1 1 to 256 R --- Bit, I16, U16

PI 32 1 to 128 R --- Bit, I32, U32, Float

MA 32 1 to 256 R/W --- Float

MD 1 1 to 256 R/W --- Bit, I16, U16

AO 16 1 to 64 R/W --- Bit, I16, U16

DO 1 1 to 128 R/W --- Bit, I16, U16

AIS  *1 16 1 to 128 R/W --- Bit, I16, U16

DIS  *2 1 1 to 256 R/W --- Bit, I16, U16

PIS  *3 32 1 to 128 R/W --- Bit, I32, U32, Float

*1  AIS: AI control input
*2  DIS: DI control input
*3  PIS: PI control input

15.4.5  TR30 (Modbus/TCP)
The table below shows devices of TR30 unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

AI 16 1 to 64 R --- Bit, I16, U16

DI 1 1 to 64 R --- Bit, I16, U16

PI 32 1 to 32 R --- Bit, I32, U32, Float

OI 32 1 to 32 R --- Bit, I32, U32, Float

IREG  *1 1 1 to 3 R/W --- Bit

STS  *2 1 1 to 2 R --- Bit

ERR  *3 1 1 to 3 R --- Bit

AIS  *4 16 1 to 64 R/W --- Bit, I16, U16

DIS  *5 1 1 to 64 R/W --- Bit, I16, U16

PIS  *6 32 1 to 32 R/W --- Bit, I32, U32, Float

*1  IREG: Internal register ([1]: Record  [2]: Transfer  [3]: Comment) 
*2  STS: Status ([1]: SD card error  [2]: FTP transmission)
*3  ERR: Error status ([1]: SD card error  [2]: R30 module error  [3]: Modbus/TCP error)
*4  AIS: AI control input
*5  DIS: DI control input
*6  PIS: PI control input
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15.4.6  FA-M3 (Modbus/TCP)
The table below shows devices of FA-M3 unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

I 1 1 to 65535 R/W --- Bit, I8, U8, I16, U16, I32, U32

X 1 201 to 71664 R --- Bit, I8, U8, I16, U16, I32, U32

M 1 1 to 9984 R --- Bit, I8, U8, I16, U16, I32, U32

Z 16 1 to 1024 R LE Bit, I8, U8, I16, U16, I32, U32

D 16 1 to 65535 R/W LE Bit, I8, U8, I16, U16, I32, U32

Note: Address of X-device is configured as following table, thus the device number is discontinuous.
Address not existing is also configurable but an error message will be indicated when executing build process.
Refer to the users manual of Yokogawa FA-M3 series for details.

X 0 02 01

Terminal Number (01 - 64)

Slot Number (02 - 16)

Unit Number (0 - 7)



207
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

15.4.7  MELSEC-iQR (SLMP)
The table below shows devices of MELSEC-iQR CPU unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

M 1 0 to 161882111 R/W --- Bit, I8, U8, I16, U16, I32, U32

X 1 0 to 0x2fff  *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

Y 1 0 to 0x2fff  *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

D 16 0 to 10117631 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

SM 1 0 to 4095 R/W --- Bit, I8, U8, I16, U16, I32, U32

SD 16 0 to 4095 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

L 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

F 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

V 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

B 1 0 to 0x9a61fff  *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

W 16 0 to 0x9a61ff  *1 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

TS 1 0 to 8993439 R/W --- Bit

TC 1 0 to 8993439 R/W --- Bit

TN 16 0 to 8993439 R/W --- U16

LTS 1 0 to 2529407 R/W --- Bit

LTC 1 0 to 2529407 R/W --- Bit

LTN 32 0 to 2529407 R/W --- U32

STS 1 0 to 8993439 R/W --- Bit

STC 1 0 to 8993439 R/W --- Bit

STN 16 0 to 8993439 R/W --- U16

LSTS 1 0 to 2529407 R/W --- Bit

LSTC 1 0 to 2529407 R/W --- Bit

LSTN 32 0 to 2529407 R/W --- U32

CS 1 0 to 8993439 R/W --- Bit

CC 1 0 to 8993439 R/W --- Bit

CN 16 0 to 8993439 R/W --- U16

LCS 1 0 to 4761215 R/W --- Bit

LCC 1 0 to 4761215 R/W --- Bit

LCN 32 0 to 4761215 R/W --- U32

SB 1 0 to 0x9a61fff  *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

SW 16 0 to 0x9a61ff  *1 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

Z 16 0 to 23 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

LZ 32 0 to 11 R/W LE U32

ZR 16 0 to 5832703 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

*1  '0x' denotes hexadecimal.

Note:  �
•	 Word-access to a Bit device is supported for reading only with a single command when the device number is a multiple 

of 16.
•	 �Long-word-access to a Bit device is supported for reading only with a single command when the device number is a mul-

tiple of 32.
•	 Long-word-access to a Word device is supported for reading only with a single command when the device number is a 

multiple of 2.
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15.4.8  MELSEC-iQF (SLMP)
The table below shows devices of MELSEC-iQF CPU unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

M 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

X *1 1 0 to 1023 R/W --- Bit, I8, U8, I16, U16, I32, U32

Y *1 1 0 to 1023 R/W --- Bit, I8, U8, I16, U16, I32, U32

D 16 0 to 7999 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

SM 1 0 to 9999 R/W --- Bit, I8, U8, I16, U16, I32, U32

SD 16 0 to 11999 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

L 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

F 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

B 1 0 to 0x7fff *2 R/W --- Bit, I8, U8, I16, U16, I32, U32

S 1 0 to 4095 R/W --- Bit, I8, U8, I16, U16, I32, U32

W 16 0 to 0x7fff  *2 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

TS 1 0 to 1023 R/W --- Bit

TC 1 0 to 1023 R/W --- Bit

TN 16 0 to 1023 R/W --- U16

STS 1 0 to 1023 R/W --- Bit

STC 1 0 to 1023 R/W --- Bit

STN 16 0 to 1023 R/W --- U16

CS 1 0 to 1023 R/W --- Bit

CC 1 0 to 1023 R/W --- Bit

CN 16 0 to 1023 R/W --- U16

SB 1 0 to 0x7fff *2 R/W --- Bit, I8, U8, I16, U16, I32, U32

SW 16 0 to 0x7fff *2 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

LCS 1 0 to 1023 R/W --- Bit

LCC 1 0 to 1023 R/W --- Bit

LCN 32 0 to 1023 R/W --- U32

Z 16 0 to 23 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

LZ 32 0 to 11 R/W --- U32

R 16 0 to 32767 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

*1  'X' and 'Y' devices are denoted in octal.
*2  '0x' denotes hexadecimal.

Note:  �
•	  �Word-access to a Bit device is supported for reading only with a single command when the device number is a multiple 

of 16.
•	 �Long-word-access to a Bit device is supported for reading only with a single command when the device number is a mul-

tiple of 32.
•	 �Long-word-access to a Word device is supported for reading only with a single command when the device number is a 

multiple of 2.
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15.4.9  MELSEC-Q (SLMP)
The table below shows devices of MELSEC-Q CPU unit.

CODE NO. OF BITS DEVICE NUMBER ACCESS ENDIAN ACCESS TYPE

M 1 0 to 61439 R/W --- Bit, I8, U8, I16, U16, I32, U32

X 1 0 to 0x1fff *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

Y 1 0 to 0x1fff *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

D 16 0 to 4910079 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

SM 1 0 to 2047 R/W --- Bit, I8, U8, I16, U16, I32, U32

SD 16 0 to 2047 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

L 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

F 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

V 1 0 to 32767 R/W --- Bit, I8, U8, I16, U16, I32, U32

B 1 0 to 0xbfff *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

W 16 0 to 0x4aebff *1 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

TS 1 0 to 32767 R/W --- Bit

TC 1 0 to 32767 R/W --- Bit

TN 16 0 to 32767 R/W --- U16

STS 1 0 to 32767 R/W --- Bit

STC 1 0 to 32767 R/W --- Bit

STN 16 0 to 32767 R/W --- U16

CS 1 0 to 32767 R/W --- Bit

CC 1 0 to 32767 R/W --- Bit

CN 16 0 to 32767 R/W --- U16

SB 1 0 to 0x7fff *1 R/W --- Bit, I8, U8, I16, U16, I32, U32

SW 16 0 to 0x6fff *1 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

Z 16 0 to 19 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

ZR 16 0 to 4849663 R/W LE Bit, I8, U8, I16, U16, I32, U32, Float

*1  '0x' denotes hexadecimal.

Note:  �
•	  �Word-access to a Bit device is supported for reading only with a single command when the device number is a multiple 

of 16.
•	 �Long-word-access to a Bit device is supported for reading only with a single command when the device number is a mul-

tiple of 32.
•	 �Long-word-access to a Word device is supported for reading only with a single command when the device number is a 

multiple of 2.
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16.  APPENDIX

16.1  PROHIBITED CHARACTERS
The table below shows characters which are prohibited to use on RGP-Designer.
An error occurs if operators (such as +, -, XOR, etc.) are included. 

PROHIBITED 
CHARACTER

UNICODE

" 0x0022

' 0x0027

0x005c

Make sure NOT to use these characters when entering in the fields in relation to the followings.

•	 String Table

•	 Symbol variables

•	 Parts names

•	 Comments (in the Property of GP folder)



211
Graphic Panel Designing Software

 for RGP30 series  EM-8581-B  Rev.6

MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

16.2  ERROR HANDLING

16.2.1  RGP error
	■ Error types

There are two major error types with regard to RGP unit.

•	 Setting file error (cleared when a normal file is retransferred), EEPROM error

•	 Communication error with a slave (cleared when normal communication is restored or communication with the 
slave is terminated)

	■ Error notification

Error is indicated by the following methods.

•	 LED lamp of RGP unit 
RGP30: ERROR LED blinks.
RGP6  : Status indicator LED turns ON Red.

•	 System log
Error is written in the system log.
System log is recorded in 'LOG.txt' and 'LOG1.txt' in the LOG folder.
When the file size of 'LOG.txt' exceeds 1 MB, the file is renamed 'LOG1.txt' and a new 'LOG.txt' file is created 
to record System log. 

System log can be viewed from Web browser.
Enter an address of each file in the address bar of Web browser.

	 http://(IP Address of RGP)/LOG/LOG.txt 

	 http://(IP Address of RGP)/LOG/LOG1.txt

Note that the access level of LOG folder is set to '0' at default.

Refer also to Users Manual (NM-8582-B; currently available in Japanese only) of RGP6 for details of System log.
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16.2.2  Browser
When an communication error between RGP unit and a slave device occurs, an error message as shown below 
is displayed at the top of the screen when either of the following conditions is met.

•	 When the slave device has failed to respond to a read request from the RGP unit within 5 seconds for 5 
times in a row.   
Once an error message is displayed, it will not be refreshed while the slave device repeats the failure. 
The error state is cleared when the slave device has responded to a read request next time. 
Alert dialog of read request recovers automatically by normal response.

•	 When a slave device does not respond to a write request from the RGP unit. 
Or when an error code is received from the RGP, displays the message in the upper red band of each 
screen. 
Click the message to delete the alert dialog of write request.

16.3  USER REGISTRATION
	■ Free User Registration

We strongly recommend to sign up as a user and receive information on the version upgrade of the RGP firm-
ware or RGP-Designer software. 

Go to our web site, then to the User Registration Page (currently available from Japanese site only) and register 
your details. 
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16.4  TROUBLESHOOTING

16.4.1  Status indicator LEDs
	■ RGP30

Problem faced What to check Method of handling

PWR LED does not turn ON. Is the RGP unit powered ON? Check the power supply. 
Turn OFF and ON the power supply. 
Consult us if the problem persists.

RUN LED does not turn ON. Is the RGP unit powered ON? Check the power supply. 
Turn OFF and ON the power supply. 
Consult us if the problem persists.

ERROR LED is blinking. Communication error with a slave? See "16.2 ERROR HANDLING" on page 211

	■ RGP6

Problem faced What to check Method of handling

Status Indicator LED does 
not turn ON Green.

Is the RGP unit powered ON? Check the power supply. 
Turn OFF and ON the power supply. 
Consult us if the problem persists.

Status Indicator LED turns 
ON Red.

Communication error with a slave? See "16.2 ERROR HANDLING" on page 211.

16.4.2  RGP-Designer

Problem faced What to check Method of handling

Unable to connect with the 
RGP unit.
(via the LAN) 

Is the IP Address correct? Connect using a USB cable, and check the IP 
Address.
See "2.5 SETTING/CHANGING RGP IP AD-
DRESS" on page 22.

Has the LAN cable come out of the 
HUB?

Connect the LAN cable securely.

Has the same network address 
been specified in the IP Address of 
the RGP and PC?

Check the IP Address. 
Issue the ping command from the PC and check 
whether there is a response from the RGP unit.
[Example]
     RGP : 192.168.0.1
     PC : 192.168.0.2
     Subnet mask : 255.255.255.0

Are the user ID and password cor-
rect?

Confirm the user ID and password.
See 3.4 TOOL MENU > "3.4.12 Setup Target 
Unit" on page 49.

Unable to connect with the 
RGP
(via the Internet)

Is the port No. on the router used 
by RGP-Designer (default: 30559) 
open?

Set the IP Address of the RGP and port No. 
manually in the NAT setting of the router.   
(See the User Manual of the router.)

Unable to transfer Project to 
the RGP unit

Has the build process been suc-
cessful?

Confirm the build process result on the [Output] 
window.
See "3.13 OUTPUT WINDOW" on page 63.
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16.4.3  Displaying the Web browser via LAN connection

Problem faced What to check Method of handling

Unable to display the Web 
browser view via the LAN.

Is the URL correct? Confirm the URL and try again.
See "5.4 ACCESS RGP VIA WEB BROWSER" 
on page 80.

Has the LAN cable come out of the 
HUB?

Connect the LAN cable securely.

Is the IP Address of the RGP over-
lapping with another device?

Check the IP Address.

Has the same network address 
been specified in the IP Address of 
the RGP and PC?

Check the IP Address.   
Issue the ping command from the PC and check 
whether there is a response from the RGP unit.
[Example]
     RGP : 192.168.0.1
     PC : 192.168.0.2
     Subnet mask: 255.255.255.0

Has firewall or proxy server setting 
been configured on the PC?

Check the contents of the firewall and proxy 
server setting with the network administrator.

Are you using a compatible terminal 
and compatible browser?

Check the version of the terminal/browser 
software.
See "1.9 OTHERS" on page 16.

Is there a problem with the terminal 
or PC being used?

Use a different terminal/PC.

16.4.4  Wi-Fi connection

Problem faced What to check Method of handling

Unable to connect to the 
access point from a terminal/
PC.

Is the password to the access point 
correct?

Check the password to the access point.   
(See the User Manual of the access point)

Has an IP Address been assigned 
to the terminal/PC?

Check that the access point has a DHCP server 
function.  If not, enter the IP Address manually.  
(See the User Manual of the access point)
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16.4.5  Internet

Problem faced What to check Method of handling

Unable to connect to the 
Internet (provider).

Does the information used to con-
nect to the provider match the set-
ting in the router?  
(User name, password, etc.)?

Check the provider-related settings on the router.   
(See the provider information and the User 
Manual of the router)

If a mobile router is being used, is 
the signal weak?

Check the signal strength. 
Try again in a location where the signal is strong.

Have the IP Address and default 
gateway of the RGP been correctly 
set? 

Check the IP Address and default gateway set-
ting for the RGP.
See "2.5 SETTING/CHANGING RGP IP AD-
DRESS" on page 22.

Unable to display the RGP 
Graphic Panels via the 
Internet.

Is the URL correct? Check the fixed IP Address or domain name of 
the WAN as per the agreement with the provider.  
(See the contents of the agreement with the 
provider.)

If the IP Address of the RGP is 
manually set, is the port open?

Set the IP Address of the RGP and port No.  
(default: 80) manually in the NAT setting of the 
router.
(See the User Manual of the router.)

If the IP Address of the RGP is set 
as [Automatic setting (DHCP)], has 
the IP Address been assigned by 
the router?

Obtain the IP Address from the router and set 
the IP Address and port No. (default: 80) from 
the NAT setting manually.   
(See the User Manual of the router.)

16.4.6  Modbus/TCP (Master)

Problem faced What to check Method of handling

Unable to connect to the 
Modbus slave device from 
the RGP unit.

Is the LAN cable disconnected or 
has it come out from the HUB?

Connect the LAN cable securely. 
Check the connection status indicator lamp on 
the HUB.

Has the IP Address of the RGP 
been manually set?

Set the IP Address manually.
See "2.5 SETTING/CHANGING RGP IP AD-
DRESS" on page 22.

Has the same network address 
been specified in the RGP and 
Modbus slave device? 

Check the network address.
[Example]
     RGP: 192.168.0.1
     Slave: 192.168.0.2
     Subnet mask: 255.255.255.0

Does the IP Address of the Modbus 
slave device coincide with the one 
registered on RGP-Designer? 

Check the IP Address of the Modbus slave 
device.

Has the IP Address been set for the 
slave device?

Set the IP Address for the Modbus slave device. 
For our remote I/O, disconnect and restart the 
power supply after setting the IP Address.   
(See the respective remote I/O Users Manuals 
for how to set the IP Address.)
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16.4.7  SLMP (Master)

Problem faced What to check Method of handling

Unable to connect to the 
SLMP slave device from the 
RGP unit.

Is the LAN cable disconnected or 
has it come out from the HUB?

Connect the LAN cable securely. 
Check the connection status indicator lamp on 
the HUB.

Has the IP Address of the RGP 
been manually set?

Set the IP Address manually.
See "2.5 SETTING/CHANGING RGP IP AD-
DRESS" on page 22.

Has the same network address 
been specified in the RGP and 
SLMP slave device? 

Check the network address.
[Example]
     RGP: 192.168.0.1
     Slave: 192.168.0.2
     Subnet mask: 255.255.255.0

Does the IP Address of the SLMP 
slave device coincide with the one 
registered on RGP-Designer? 

Check the IP Address of the SLMP slave device.

Has the IP Address been set for the 
slave device?

Check the IP Address of the SLMP slave device 
and set the IP Address, if necessary.

Do the Network No., Station No., 
and Processor No. coincide with the 
ones registered on RGP-Designer?

Check the Network No., Station No., and Pro-
cessor No. of the SLMP slave device.
See "6.1.2 MELSEC Q / iQ-R / iQ-F Series (Mit-
subishi Electric)" on page 90.

16.4.8  INTERNET BROWSER

Problem faced What to check Method of handling

The browser is forcibly termi-
nated.

Is the browser the latest version? Update the browser to the latest version.

Are brouser add-on programs used? Some add-on programs interfere with communi-
cation between RGP and the browser.
Uninstall the add-on program and try it again.

Is the Internet Explorer used? Internet Explorer is out of support and no fixed 
version will be released.
Use another browser.

Is the Firefox for Windows used?

Firefox is a registered trademark of 
the Mozilla Foundation in the United 
States and other countries.

Firefox consumes a lot of memory to prioritizes 
processing speed.
Thus, the system may become unstable after 
long-term use.
If the system becomes unstable or the browser 
quits, try the following:
Uncheck Firefox's [Settings]-[Options]-
[Performance]-[Use Recommended Perfor-
mance Settings].
Uncheck [Use hardware acceleration when 
available].
Close the Options tab and restart Firefox.
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16.5  VERSION HISTORY

16.5.1  Rev.1

•	 Revised to reflect upgrades of products.

PRODUCT UPGRADED VERSION

RGP-Desinger ver. 1.5

RGP30 ver. 1.1

RGP6 ver. 1.1

16.5.2  Rev.2

•	 The time zone setting of the RGP was added.

16.5.3  Rev.3

•	 The R30-NE1 was added to the device to be connected of Modbus/TCP.

16.5.4  Rev.4

•	 The company name was changed from M-System Co., Ltd. to MG Co., Ltd.

16.5.5  Rev.5

•	 Cautions and notes were added.

16.5.6  Rev.6

•	 RGP30-W was supported.

•	 Windows 11 was added to OS in the system requirement. 
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17.  LICENSE
exPat (http://expat.sourceforge.net/) is built into RGP/RGP-Designer.  
This license is the same as the MIT/X Consortium License.

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (c) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documen-
tation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, 
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Soft-
ware.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUD-
ING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF 
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

RGP/RGP-Designer contains software to which the following Camellia license is applicable.

camellia.c ver 1.2.0

Copyright (c) 2006,2007
NTT (Nippon Telegraph and Telephone Corporation).  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1.

2.

Redistributions of source code must retain the above copyright notice, this list of conditions and the following dis-
claimer as the first Lines of this file unmodified.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY NTT ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL NTT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT  (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGE.

The terms HDMI, HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trade-
marks of HDMI Licensing Administrator, Inc.

1.

2.

Redistributions of source code must retain the above copyright notice, this list of conditions and the following dis-
claimer as the first Lines of this file unmodified.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.
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